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شروع کار-  1 
مفاهیم اولیه- 1.1 

ارائههدرهلغتهبههمعنا‌یه(نمودن)هنشانهدادنهوهنمایشهدادنهاستهوهدرهزبانهفارسیهبصورتهارائههکردنهوهارائههدادنهبکار
همیهرود،هارائههیکهمطلبهیعنیهانتقالهاطلاعاتهلزمهپیرامونهآنهمطلبهتاهمخاطبهآنهمطلبهراهبههخوبیهدرکهنماید.ه

رسانههوهمحیطهارائههمیهباشد.هطبهوهکانالهمخاطب،هپیام،ههبرا‌یهارائههیکهمطلبهشامل:همخاعناصر مرتبط
:هارائههکننده،همخاطب،هموضوع،هنوعهارائه،هانگیزههوه‌هدفهارائه،هامکاناتهآمادههساز‌یهمحتوا‌یهارائه،عوامل موثر در ارائه

امکاناتهکمکیهارائه،همدتهزمانهارائه،هزمانهوهتاریخهارائه،همکانهارائه،هجغرافیا‌یهارائههوهوضعهاجتمااعیهمحیطهارائههمیهباشد.ه

برخی نکات مهم در ارائه:
ازهبکارهبردنهکلماتهوهاعباراتهابهامهانگیزهاجتنابهکنیم.ه•
دره‌هرهلحظههسعیهکنیمهوضعیتهمخاطبینهیعنیهمیزانهکشش،هاعلاقههوهحوصههلههآنهههاهراهبههههشههنیدنهوهدنبههالهکهردن•

مطلبهدرکهکنیم.ه
ازهنگاههبرا‌یهبراقرارهکردنهارتباطهپویاهباهمخاطبینهوهتاثیرگذار‌یهرو‌یهآنهاهبههخوبیهاستفادههکنیمهوهدرهتقسیمهنگاههبیههن•

مخاطبینهاعدالتهداشتههباشیم.ه
ازهحرکاتهدستهبطورهمناسبهوهبقدرهکافیهبهرههبگیریم.ه•
ثابتهوهبیهحرکتهنباشیم.ه•
حتیهالمکانهمخاطبینهراهدرهارائههمشارکتهد‌هیم.ه•
گاههگاههوهبههااقتضا‌یهمواقعهوهمطلبهباهراعایتهجوانبهاعرفیهوهفر‌هنگیهکلمهخودهراهتلطیفهکنیم.ه•
ازهتفاخر،هتکبر،هخودنمایی،هوهفضلهفروشیهپر‌هیزهکنیم.ه•
باهاطمینانهسخنهبگوییمهوه‌هرهجاهکههتردیدهداشتیمهآنهراهصریحاهااعلمهکنیم.ه•
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خصوصیات محتوا- 1.1.1 

سادگی:
سادگیهدرهارائهها‌همیتهبسیارهبالییهداردهتاهبتوانیمهجانهکلمهراهبههمخاطبینهانتقالهد‌هیم،هپرداختنهبههاصلهموضوعهبا

زبانهسادههبدونهکمترینهحاشیههمیهتواندهبههراحتیهمطلبهراهمنتقلهکند.

خلصه و رسا:
20هاسههلیدهوه20سخنرانانهراهبهههه.هپیچاهکوچاههاست1یکهراههخوبهبرا‌یهحذفهمطالبهزائد،هاستفادههازهسبکهپیچاهکوچا

هثانیهاسهت.هبههه‌همیههنهدلیههلهاسهتهکهههرویهداد‌ها‌ی40هداقیقههههوه6ثانیههزمانهبرا‌یه‌هرهاسلیدهوهرسیدنهبههاصلهکلمهدره‌هره
پیچاکوچاهدرهسراسرهجهانهبههمحبوبیتهرسیدههاست،هچراهکههافرادهخلاقهبدونهصرفهزمانهطولنیهمیهتوانندهایدهه‌ها‌یهخههودهرا

باهدیگرانهبههاشتراکهبگذارند.
بههیادهداشتههباشیدهکههافرادهازهشنیدنهایدهه‌ها‌یهجدیدهاستقبالهمیهکنندهاماهتمرکزهآنهاهتنهاهبرا‌یهمدتهکوتا‌هیهمیهتوانههد

بههیکهموضوعهجلبهگردد.

Impressآشنایی با ویژگی ها و کابرد نرم افزار - 1.1.2 
کابردهاینهنرمهافزارهارائهه‌یهمطالبهبههمخاطبانهبههصورتهتکیهوهیاهارائهه‌همزمانهازهطریقهچندهنمایشگرهاسههتهکههههبههرا‌ی

ارائهه‌یهمقالتهوهمستنداتهدرهکنفرانسه‌هاهوهجلساتهاستفادههمیهشود.

آشنایی با محیط نرم افزار- 1.2 
توانایی اجرا و بستن نرم افزار- 1.2.1 

اجرای نرم افزار
هبههمنو‌یهاصلیهمیزکارهمیهرویم..1
هکلیکهمیهکنیم.Applicationبرهرو‌یهگزینهه.2

1 PechaKucha
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هراهانتخابهمیهکنیم.Officeهبخشه.3
هراهاجراهمیهکنیم.LibreOffice ImpressهیاهPresentationبرنامهه.4

هنشانهدادههایم.1.1شکله‌همانطورهکههدره

 بستن نرم افزار
رهگوشهه‌یهبالهوهسمتهراستهصفحههنمایشهکلیکهمیهکنیم.کونهضربدرهدبرهرو‌یهآی•
همیهرویم.File>Exit LibreOfficeهبرا‌یهبستنهنرمهافزارهبههمسیره•
هاستفادههمیهکنیم.Ctrl+Qهباهروشهدیگرهازهکلید‌ها‌یهمیانبره•

 از منوی اصلی میزکارImpress: اجرای نرم افزار 1.1شکل 
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آشنایی با پنجره ‌ی اصلی- 1.2.2 
لیدImpressپنجرههاصلیهنرمهافزاره شهاس ت:هبخ شهاس ار‌یSlideهدارا‌یهسههبخ ا‌یهک ایدبار.Workspace،هفض هوهس

Sidebarههدره شکلههبعلوه،هدرهطولهساختهیکهارائههچندینهنوارهابزارهمیهتواندهنمایشهدادههشدههوهیاهپنهانهشود.ه‌همانطورهک
هنشانهدادههایم.1.2

نوارهکنار‌یهدارا‌یه‌هفتهاقسمتهاست.هبرا‌یهدیدنهجزئیاتهاقسمتیهکهههمیهخوا‌هیمهاستفادههکنیم،هبههرهرو‌یهآیکهونهآنهیهها
مثلثهکوچکیهکههدرهکنارهآیکونه‌هاهاست،هکلیکهکردههوهازهلیستهکشوییهیکهگزینههراهانتخابهمیهکنیم.هتنهههاهیهکهاقسهمتهدر

یکهزمانههمیهتواندهبازهباشد.ه

نوارهابزار‌هاییهنیزهدرهاینهاقسمتهاقرارهدارندهکههبههبرخیهازهآنه‌هاهاشارههمیهکنیم.هجزئیاتهاینهپنجرههراهدرهزیرهمیهبینیم:ه

Impress: محیط نرم افزار 1.2شکل 

نوار عنوان

پنجره اسلیدها

نوار ابزار

فضای کاری نوار وضعیت
نوار ترسیمات

نوار کناری



19جزوهه‌یهآ‌موزشیه‌مهارتهکارهباهنرمهافزارهارائهه‌مطلب

نوار عنوان:
دنهدرهآنهدیههدهدنهوهکمینههههکههربالترینهنوارهکههنامهنرمهافزارهبهه‌همراههاسمهفایلهوهدکمهه‌ها‌یهبستن،هتمههامهصههفحههکههر

میهشود.
پنجره اسلیدها:

پنجرههاسلید‌هاهشاملهاعکسه‌ها‌یهکوچکیهازهاسلیده‌هاهدرهارائههاست،هکههبصورتهمنظمهنشانهدادههخوا‌هدهشد،همگرهاینکه
ماهنظمهنمایشهاسلیدهراهتغییرهد‌هیمهباهکلیکهبرهرو‌یهیکهاسلیدهدرهاینهپنجرههآنهراهانتخابهوهدرهفضا‌یهکار‌یهاقرارمیهد‌هیههم.

‌هنگامیههکههیکهاسلیدهدرهفضا‌یهکار‌یهاست،ههماههمیهتوانیمه‌هرهگونههتغییر‌یهکههمیهخوا‌هیمهراهانجامهد‌هیم.ه
نوار ابزار استاندارد: 

View> Toolbars> Standardنوارهابزارهاستانداردهشاملهآیکونه‌ها‌یهمتنواعیهاستهکههبرا‌یهفعاهلهکردنهآنهبههمسیره

میهرویم.هبرا‌یهغیرهفعالهکردنهاینهنوارهابزارهنیزهبهه‌همینهمسیرهرفتههوهگزینهه‌یهاینهنوارابزارهراهبیهاعلمتهمیهکنیم.ه
نوار ابزار ارائه: 

الPresentstionرفتههوهگزینهه‌یهView>Toolbarsبرا‌یهنمایشهنوارابزارهارائههبههمسیره رهفع هراهفعالهمیهکنیم.هبرا‌یهغی
هراهازهحالتهاعلمتهدارهبرمیهداریم.هتمامیهنوارهابزاره‌ها‌یهموجودPresentationکردنهاینهنوارهابزارهبههمسیرهبالهرفتههوهگزینهه‌یه

نView>Toolbarsهراهمیهتوانهباهرفتنهبههمسیرimpressدرهنرمهافزار هدرهدسترسهاقرارهداد.هباهاعلمتهدارهکردنه‌هرهکدامهازهای
گزینهه‌ها،هنوارهابزارهموجودهدرهمحیطهنرمهافزارهاقرارهمیهگیردهوهمیهتوانیمهبههراحتیهازهآنهاستفادههنماییم.ه

آشنایی با بخش ها‌ی اصلی نرم افزار - 1.2.3 
را‌یXهراهباهکلیکهبرهرو‌یهSidebarههوهیاهSlidesماهمیهتوانیمهپنجرهه هدرهگوشههسمتهراستهبال‌یه‌هرهپنجرههببندیمهوهیاهب
یاهView > Slide Paneاعدمهنمایشهپنجرههبهه برا‌یهنمایشهمجددView > Sidebarه نوارهمنوهاصلیهمراجعههکنیم.ه برهرو‌یه ه

هراهدوبارههانتخابهمیهکنیم.هSidebarهیاهSlide PaneهرفتههوهViewپنجره،هدرهنوارهمنوهاصلیهبهه
‌همچنینهمیهتوانیمهمحیطهفضا‌یهکار‌یهراهباهکلیکهبرهرو‌یهنشههانگرهنمههایشه/هاعههدمهنمههایشهدرهوسههطهخههطهجداکننههده

Slidesاعمود‌یهبههحداکثرهبرسانیم.هباهاستفادههازهنشانگرهنمایشه/هاعدمهنمایش،ه  paneهوهیاهSidebarته همخفیههمیهشوندهاماهبس
نمیهشوند.هبرا‌یهبازگرداندنهپنجره،هبایدهدوبارههبرهرو‌یهنشانگرهنمایشه/هاعدمهنمایشهکلیکهکنیم.ه
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نمایش یا عدم نمایش بخش ها‌ی نرم افزار- 1.2.4 
بسیار‌یهازهنوارابزار‌هاهدره‌هنگامهساختهاسلیدهمیهتوانندهاستفادههشوند؛هاینهنوارابزار‌هاهباهرفتنهبههنوارهمنوهاصلی،هگزینههه

View> Toolbarsهنشان1.3شکلههوهانتخابهآنه‌هاهازهمنو‌یهزمینه،همیهتوانندهنمایشهدادههشدههیاهمخفیهشوند،ه‌همانطورهکههدره
دادههایم.ه

ه‌همچنینههمیهتوانیمهآیکونه‌هاییهراهکهههمیهخوا‌هیمهدره‌هرهنوارابزارهظا‌هرهشوند،هانتخابهکنیم.ه

مدیریت کلیدها‌ی میانبر- 1.2.5 
للهبرا‌یهذخیرههکههردنهاسههلید‌هاهازهکلیههدمیانهبر برا‌یهاجرا‌یهیکهفرمانهمیهتوانیمهازهکلید‌ها‌یهمیانهبرهاستفادههکنیم،همث

: نحوه نمایش داده نوارابزارها1.3شکل 
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Ctrl+Sهوهبرا‌یهچاپهCtrl+Pهیاه‌هنگامیهکههکلیدهAltهراه‌همراههباهEان ابهفرم هفشارهد‌هیمهاینهکلیدهمیانبرهبههماهاجازهه‌یهانتخ
Edit.هازهمنو‌یهاصلیهمیهد‌هد

ماهمیهتوانیمهیکهکلیدهمیانبرهصفحههکلیدهراهبههیکهفرمانهاختصاصهد‌هیم.هبرا‌یهویرایشهکلید‌ها‌یهمیههانهبرهازهروشهزیههر
استفادههمیهکنیم:

هراهاجراهمیهکنیم.Tools→ Customizeفرمانه.1
هکلیکهمیهکنیم.Keyboardبرا‌یهویرایشهکلید‌ها‌یهمیانهبرهفرمانه‌هاهبرهرو‌یهزبانهه.2
هکلیدهمیانهبرهموردهنظرهراهانتخابهمیهکنیم.Shortcut Keysدرهبخشه.3
هفرمانهموردهنظرهراهانتخابهمیهکنیم.Functionsدرهبخشه.4
هنشانهدادههایم.1.4شکلههراهکلیکهمیهکنیم،ه‌همانطورهکههدرهModifyگزینهه.5
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برا‌یهویرایشهکلید‌ها‌یهمیانهبرهمنو‌هاهبههروشهزیرهاعملهمیهکنیم:
هراهاجراهمیهکنیم.Tools→ Customizeفرمانه.1
هکلیکهمیهکنیم.Menusبرا‌یهویرایشهکلید‌ها‌یهمیانهبرهمنو‌هاهبرهرو‌یهزبانهه.2
یکهمنوهراهازهمنو‌یهکشوییهانتخابهمیهکنیم..3
هراهانتخابهمیههکنیم.RenameهکلیکهمیهکنیمهوهگزینههModifyبرهرو‌یه.4
Newدرهجعبههمتنه.5  name،م تفادههکنی انهبرهاس وانهمی هیکهاعلمتهمده(~)هراهدرهجلو‌یهحرفیهکههمیهخوا‌هیمهبههاعن

Customize در کادر محاوره ای Keyboard: زبانه 1.4شکل 
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اضافههمیهکنیم.
Sa~ve،هاعبارتهAlt+Vهباهفشارهدادنهکلیده‌ها‌یهSave Allبرا‌یهمثالهزمانیهکههمنو‌یهفایلهبازهاست،هبرا‌یهانتخابهفرمانه

Allهراهواردهمیهکنیم.هبرهرو‌یهOKاورههها‌یه ادرهمح Renameهکلیکهمیهکنیمهتاهنامهتغییرهکردههذخیرههشدههوهک  Menuته هبس
ههدرهCustomizeهکلیکهمیهکنیمهتاهتغییراتمانهذخیرههشدههوهکادرهمحاورهها‌یهOKشود.هبرهرو‌یه انطورهک ود،ه‌هم 23هبستههش
نشانهدادههایم.

ط‌Impressهمهچنینهمیهتوانیمهمیانبره‌هاهراهبههاعملیاته‌ها‌یهاستاندارده اهراهفق مهوهآنه‌ه اصهد‌هی انهاختص هدرهماکرو‌هایم
همناسبهذخیرههنماییم.هLibreOfficeهیاهباهنرمهافزارهImpressبرا‌یهاستفادههباه

Customize: کادر محاوره ای 1.5شکل 



هجزوهه‌یهآ‌موزشیه‌مهارتهکارهباهنرمهافزارهارائهه‌مطلب24

تر‌یCustomizeکلیده‌ها‌یهمیانبر‌یهکههبرا‌یهدوبارههاختصاصهدادنهموجودهنیستند،هدرهلیستهکادرهمحههاورهها‌یه ،هخاکس
هنشانهدادههایم.ه1.6شکله.ه‌همانطورهکههدرهF10هوهF1میهشوند.هبرا‌یهمثال،ه

 ایجاد یک سند ارائه - 1.3 
ایجاد سند خالی- 1.3.1 

روشه‌ها‌یهمختلفیهبرا‌یهایجادهیکهسندهخالیهوجودهدارد:ه

Customize کادر محاوره ای keyboard: بخش 1.6شکل 
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همیهرویمهوهبستههبههنیازمانهیکیهازهانواعهسند‌ها‌یهموجودهراهانتخابهمیهکنیم.File>Newبههمسیره•
وعStandardهدرهنوارهابزارهNewبرهمثلثهکوچکیهکههدرهسمتهراستهآیکونه• اه‌همههن ردههوهازهاینج کهک هاقرارهداردهکلی

سندهموردهنظرهراهانتخابهمیهنماییم.
هاستفادههکردههوهسندهجدید‌یهراهایجادهمیهکنیم.Ctrl+Nازهترکیبهکلید‌ها‌یهمیانبره•

ایجاد سند جدید بر اساس یک الگو - 1.3.2 
ودFile>Tempelateاگرهبخوا‌هیمهیکهسندهراهبرهاساسهالگوهایجادهنماییم،هبههمسیره ازهمیهش ههب وییهک همیهرویمهوهازهمن

Manageهراهانتخابهمیهکنیم.هباهانتخابهاینهگزینه،هکادرهمحاورهها‌یهManageگزینهه‌یه  tempelateادر نهک هبازهمیهشود.هدرهای
هنشانهدادههایم.1.7شکلهالگو‌ها‌یهپیشفرضهنمایشهدادههمیهشودهکههیکیهازهاینهالگو‌هاهراهانتخابهمیهکنیم.ه‌همانطورهکههدره
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باز کردن سند - 1.3.3 
نOpenهرفتههتاهکادرهمحاورهها‌یهFile>Openاگرهبخوا‌هیمهسند‌یهراهدرهمحیطهنرمهافزارهبازهکنیمهبههمسیره هبازهشود.هازهای

ههروشOpenکادرهمحاورهها‌ی،هفایلهیاهسندهموردهنظرهراهانتخابهکردههوهبرهرو‌یهگزینهه‌یه ود.هب ازهش ندهب هکلیکهمیهکنیمهتاهس
هنشانهدادههایم.1.8شکلههنیزهاستفادههنماییم.ه‌همانطورهکههدرهCtrl+Oدیگرهنیزهمیهتوانیمهازهکلیدهمیانبره

Manage tempelate: کادر محاوره ای 1.7شکل 
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حرکت بین چند سند - 1.3.4 
نImpressهدرهنرمهافزاره ،هدرهصورتیهکههچندهسندهبازهداشتههباشیمهوهبخوا‌هیمهازهیکیهبههدیگر‌یهبرویمهیاهاطلاعاتیهراهبی

وانیمWindowچندهسندهجابجاهکنیمهازهمنو‌یه هاستفادههمیهکنیم،هدرهاینهمنوهفایله‌ها‌یهبازهشدههنمایشهدادههمیهشودهوهماهمیهت
بههکلیکهبرهرو‌یه‌هرهکدامهازهآنه‌هاهفایلهراهدرهحالتهویرایشهاقرارهد‌هیم.

بستن سند - 1.3.5 
هاستفادههمیهکنیمهتاهسندهبستههشود.هباهانتخابهاینهفرمانهکادرهمحاورهها‌یFile→ Closeبرا‌یهبستنهیکهسندهازهمنو‌یه

Save  Documentن رهدرهای ههزی هبازهمیهشودهکههازهماهمیهپرسدهآیاهمیهخوا‌هیدهسندهدرهسیستمتانهذخیرههشودهیاهنه؟هسههگزین

Open: کادر محاوره ای 1.8شکل 
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کادرهمحاورهها‌یهاقرارهدارد:
Saveهدستورهذخیرههسندهباهتغییرات

Don't Saveهاعدمهذخیرههساز‌ی
Cancelهنشانهدادههایم).1.9شکلههلغوهبستنهسنده(‌همانطورهکههدره

مدیریت نمایش اسلید - 1.4 
 آشنایی با نماها‌ی مختلف - 1.4.1 

هوجودهداردهکههاینNote, Handout, Normal, Outline, Slide Sorterدرهاقسمتهفضا‌یهکار‌یهپنجهسربرگهباهنامه‌ها‌یه
هنشانهدادههایم.1.10شکلهپنجهسربرگهاسلید‌هاهراهدرهنما‌ها‌یهمختلفهنشانهمیهد‌هند.ه‌همانطورهکههدره

Save Document: کادر محاوره ای 1.9شکل 
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Normalنمایش 

ایشهNormalدرهنمایشه لیدهراهدرهنم کهاس وا‌هیمهی رهبخ وند.هاگ Normal،هاسلید‌هاهبههصورتهتکیهنشانهدادههمیهش

هبرهرو‌یهاسلیدهموردهنظرهکلیکهکنیمهتاهدرهفضا‌یهکار‌یهاقرارهگیرد.Slide Paneداشتههباشیمهبایدهدرهاقسمتهپنجرهه‌یهاسلیده
Outlineنمایش 

درهاینهنمایش،همحتویاته‌همهه‌یهاسلید‌هاهدرهسمتهراستهازهفضا‌یهکار‌یهوهشمارهه‌یهاسلید‌هاهنیزهدرهروهبههرو‌یهآنه‌هاهو
درهسمتهچپهاقرارهمیهگیرند.ه

Outline  viewت لید،هلیس وعهاس هشاملهتمامهاسلید‌ها‌یهارائههبههترتیبهشمارههآنه‌هاهاست.هاینهنمایش،هاعنوانهوهموض
اسلید‌هاهبصورتهپشتهسره‌همهوهشمارههگذار‌یهاسلید‌هاهراهدرهیکهاقالبهکلیهنشانههمیهد‌هد.هدره‌هرهاسلیدهتنهاهمتهنهموجهودهدر
جعبهه(کادر)همتنهبههطورهپیشهفرض،هنشانهدادههشدههاست.هدرهاینهنمایش،هجعبههمتنهیههاهاشههکالهگرافیکههیهاضههافههشههدههبههه

هنشانهدادههایم.1.11شکلهاسلید‌هاهوه‌همهچنینهنامهاسلید،هنمایشهدادههنمیهشوند.ه‌همانطورهکههدره

: نماهای اسلیدها1.10شکل 
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هبرا‌یهمواردهزیرهاستفادهههمیهشود:Outline viewازه
ایجادهتغییرهدرهمتنه‌هرهاسلید.•
.Normal viewاضافههیاهپاکهکردنهمتنهدرهاسلیدهشبیههنمایشه•
حرکتهدرهپاراگرافه‌هاییهازهمتنهدرهاسلید‌ها‌یهانتخابهشدهه‌یهبالهیاهپایینهباهکلید‌ها‌یهفلشهبالهوهپایینه(حرکتهبههبال•

ه(هاقالبهبند‌یهمتن)هاست.Text Formattingیاهپایین)هکههدرهنوارابزاره
تغییرهیاهترازکردنهطرحهکلیهبرا‌یه‌هرهپاراگرافهدرهیکهاسلیدهباهاسههتفادههازهدکمههههفلههشهچههپهوهراسههته(افزایههشهیهها•

هاست.Text Formattingکا‌هش)هکههدرنوارابزاره
حرکتهدادنهیکهپاراگرافهوهتغییرهدادنهیاهترازکردنهطرحهکلیهاسلیدهبههطوره‌همزمانهباهاسههتفادههازهترکیههبیهازهچهههار•

دکمههفلش.

Outline: نمایش 1.11شکل 
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مقایسههاسلید‌هاهباهطرحهموردهنظرمانه(اگرهاسلید‌ها‌یهازهپیشهآمادههداریم)،هاگرهازهمقایسههطرحهخودهمتههوجههشههدیم•
Outlineکههاسلیدهدیگر‌یهنیازهاست،هماههمیهتوانیمهسههریعاهآنهراهدره  viewهه وانیمهب اههمیهت اد،هی Normalهایج  view

بازگشتههوهاسلیدهدیگر‌یهایجادهنماییم.

Notesنمایش

)،ه‌هرهاسلیدهبههصورتهجداگانههدرهفضا‌یSlide Paneدرهاینهنمایشهباهکلیکهبرهرو‌یه‌هرهاسلیدهدرهصفحهه‌یهاسلید‌هاه(
Clickکار‌یهنمایشهدادههمیهشودهوهدرهزیرهمحتویاته‌هرهاسلیدهکادر‌یهاقرارهداردهکههباهکلیکهبرهرو‌یهاعبههارته  to  add  notes

هراهنشانهمیهد‌هد.Notesمیهتوانیمهیادداشتیهراهدرهپایینه‌هرهاسلیدهتایپهکنیم.هنمایشه

Slide Sorterنمایش 

شاملهتمامیههاسلید‌هاهبصورتهکوچکهاست.هازهاینهنمایشهبرا‌یهکارهباهتعدادهزیاد‌یهازهاسلید‌هاهیاهیکهاسههلیدهاسههتفاده
هنشانهدادههایم.1.12شکلهمیهکنیم.ه‌همانطورهکههدره
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Handoutنمایش

هنشانهدادههایم.1.13شکلهدرهاینهحالتهنحوههچاپهاسلید‌هاهبرا‌یهدانشهپذیرانهنمایشهدادههمیهشود.ه‌همانطورهکههدره

Slide Sorter: نمایش 1.12شکل 



33جزوهه‌یهآ‌موزشیه‌مهارتهکارهباهنرمهافزارهارائهه‌مطلب

تسلط بر پانل دیدبان - 1.4.2 
اورهها‌یهNavigatorپانلهدیدبانهیاه را‌یهآوردنNavigatorهپانلیهاستهکههباهآنهمیهتوانهاسلیده‌هاهراهدرهکادرهمح د.هب هدی
بView>Navigatorاینهپنلهبههمسیره بینیم.هترکی مهراهب ادهکردههای ههایج لید‌هاییهک وانیمهاس قهمیهت همیهرویمهوهازهاینهطری
د‌یهوCtrl+Shift+F5کلید‌ها‌یهمیانبره لیدهبع ههاس نهب هنیزه‌همینهکادرهمحاورهها‌یهراهبرایمانهبازهمیهکند.هاینهپنلهتواناییهرفت

هنشانهدادههایم.1.14شکلهاقبلیهراهنیزهدارد.ه‌همانطورهکههدر

Handout: نمایش1.13شکل 
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تسلط بر نقشه ‌ی اسلیدها- 1.4.3 
Slideنقشههوهنمایشهاسلید‌هاهراهمیهتوانیمهدرهاقسمتهپنجرهه‌یهنمایشهاسلیده  Paneایش هکههدرهسمتهچپهصفحههنم

نشانهدادههمیهشود،هببینیم.هدرهاینهاقسمت،هباهراستهکلیکهکردنهبرهرو‌یه‌هرهاسلیدهگزینهه‌ها‌یهمختلفیهبرا‌یهاسلیدهازهجملههه
هنشانهدادههایم.1.15شکلهحذف،هتکثیر،هکپیهوهمواردهدیگرهوجودهدارد.ه‌همانطورهکههدره

Navigator: کادر محاوره ای 1.14شکل 
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 ابزار بزرگنمایی- 1.4.4 
Adjustاعموماهبرا‌یهبزرگهکردنهوهیاهکوچکهکردنهاسلید‌هاهبههاقسمته  Zoom  Levelعیتهدر وارهوض رهرو‌یهن هکههب

گوشهه‌یهسمتهراستهوهپایینهصفحههنمایش،هاقرارهداردهمیهرویمهوهازهآنجاهدرصدهبزرگنماییهاسلیدهراهتنظیمهمیهکنیم.ه‌همههانطور
هنشانهدادههایم.1.16شکلهکههدره

: نقشه اسلیدها1.15شکل 
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هبازهشدههوهازZoom & View Layoutبرا‌یهتنظیمهداقیقهتر،هبرهرو‌یهاینهاقسمتهدوبارهکلیکهمیهکنیمهتاهکادرهمحاورهها‌یه
اینهکادرهمیهتوانیمهتنظیماتهلزمهراهانجامهد‌هیم.ه

رفتههوهتغییراتهدلخواههراهبههرهرو‌یهاسههلیدهانجههام‌View>Zoomهمچنینهبرا‌یهتنظیماتهبزرگنماییهمیهتوانیمهبههمسیره
د‌هیم.ه

انواع ذخیره ساز‌ی سند - 1.5 
ذخیره، ذخیره با نام و ذخیره ‌ی یک کپی از سند - 1.5.1 

ذخیرههساز‌یهیکهسندهبههروشه‌ها‌یهزیرهامکانهپذیرهاست:

: درصد بزرگنمایی اسلید1.16شکل 

Zoom & View Layout: کادر محاوره ای 1.17شکل 



37جزوهه‌یهآ‌موزشیه‌مهارتهکارهباهنرمهافزارهارائهه‌مطلب

هکههبازهمیهشود،همسیرهذخیرههشدنSave Asهرفتههوهازهکادرهمحاورهها‌یهFile> Saveبرا‌یهذخیرههکردنهسندهبههمسیره•
را‌یSaveسندهراهانتخابهنمودههوهبرهرو‌یهگزینهه‌یه وند.هب هکلیکهمیهکنیم.هسپسهسندهدرهمسیرهدلخواههذخیرههمیهش

اSaveذخیرههساز‌یهتکیهاسلید‌هاهبهه‌همینهمسیرهرفتههباهاینهتفاوتهکههههایههنهبههارهگههزینهه‌یه م.هب ابهمیهکنی هراهانتخ
انتخابهاینهگزینه،هنیاز‌یهبههمشخصهکردنهمسیرهنیستهوهاسلیدهدره‌همانهمسیرهاقبلیهذخیرههمیهشود،ه‌همانطورهکههه

هنشانهدادههایم.1.18شکلهدره

File>Saveاگرهبخوا‌هیمهیکهسندهراهباهنامهوهدرهیکهمواقعیتهمشخصهذخیرههکنیم،هبههمسیره•  Asادر مهوهازهک همیهروی
Saveمحاورهها‌یه  Asهه‌ی رهرو‌یهگزین saveهکههبازهشدههاستهمحلهذخیرههساز‌یهسندهوهنامهآنهراهمشخصهکردههوهب

کلیکهمیهکنیم.ه
راتFile>Saveاگرهبخوا‌هیمهتغییراتیهراهدرهسند‌یهکههازهاقبلهذخیرههشدههااعمالهکنیم،هبههههمسههیره• اهتغیی مهت همیهروی

دلخواههراهااعمالهنماییم.ه

Save As: کادر محاوره ای 1.18شکل 
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هبازهشودSave a Copyهرفتههتاهکادرهمحاورهها‌یهFile>Save a Copyبرا‌یهذخیرههکردنهیکهکپیهازهسندمانهبههمسیره•
هکلیکهمیهکنیمهتاهیکهکپیsaveوهازهاینهکادرهمحاورهها‌یهمسیرهوهنامهفایلهدلخواههراهانتخابهکردههوهبرهرو‌یهگزینهه‌ی

ازهسندمانهذخیرههشود.

نگارش زنی سند - 1.5.2 
همیهرویم.هیکهکادرFile> versionبرا‌یهنگارشهزنیهیکهفایل،هابتداهفایلهموردهنظرهراهذخیرههمیهکنیمهوهسپسهبههمسیره

هکلیکهمیهکنیم.هکادرهمحاورهها‌یهدیگر‌یهنیزهباSave New Versionمحاورهها‌یهباهنامهفایلهبازهمیهشودهوهسپسهبرهرو‌یهگزینهه‌یه
Insertنامه  Version  Commentر را‌یه‌ه ارشهب هبازهشدههوهازهاینهگزینههمیهتوانهفایلهذخیرههشدههراهنگارشهزد.هباهااعمالهنگ

فایل،همیهتوانیمهبههامکاناتیهازهاقبیلهمشخصهکردنهنویسندهه‌یهفایلهوهآخرینهتاریخهنگارشهفایل،هذخیرههکردنه‌همهه‌یهنگارشه‌ها
هنشههان1.19شکلهدرهیکهفایل،همقایسههکردنهنگارشه‌هاهباه‌همهوهنگارشهزنیهفایلهباهبستنهآن،هدستهیابیم.ه‌همههانطورهکههههدره

دادههایم.

Versions: کادر محاوره ای 1.19شکل 
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 ذخیره کردن یک سند به قالب ها‌ی مختلف- 1.5.3 
‌File>Saveهنگامیهکههمیهخوا‌هیمهیکهسندهراهذخیرههکنیم،هبایدهبههمسیره  AsهرفتههوهازهاقسمتهFile  Typeادر هدرهک

Saveمحاورهها‌یه  Asرهرو‌ی پسهب م.هس ابهمیهکنی وییهانتخ هنوعهوهاقالبهدلخواههبرا‌یهذخیرههساز‌یهسندمانهراهازهلیستهکش
هنشانهدادههایم.1.20شکلههکلیکهمیهکنیمهتاهسندهباهاقالبهدلخواههذخیرههگردد.ه‌همانطورهکههدرهsaveگزینهه‌ی

 ذخیره ساز‌ی خودکار سند - 1.5.4 
اورهها‌یهTools>Optionاگرهبخوا‌هیمهسندمانهبههطورهخودکههارهذخیههرههشههودهبههههمسههیره ادرهمح اهک ههت -Optionsهرفت

Load/Save-  Generalهبازهشود.هازهسمتهچپهاینهکادرهمحاورهها‌یهاقسمتهLoad/Saveزینهه‌یه ردههوهگ ازهک هراGeneralهراهب
...Save AutoRecovery Information every،هگزینهه‌یهSaveانتخابهمیهکنیم.هدرهکادرهمحاورهها‌یهکههبازهمیهشود،هازهاقسمته

Minutesهراهاعلمتهدارهکردههوباهاینهگزینههمشخصهمیهکنیمهکههچندهثانیههیکبارهذخیرههساز‌یهخودکارهانجامهگیرد.ه

:  قالب های مختلف ذخیره سازی1.20شکل 
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آشنایی با تنظیمات ذخیره ساز‌ی- 1.5.5 
-Load/SaveهوهاقسمتهTools>Optionتنظیماتهذخیرههساز‌یهنیزهازه‌همانهمسیره  Generalام هکههدرهبالهبیانهشدهانج

میهشودهوهازهاینهکادرهماهمیهتوانیمهگزینهه‌ها‌یهمختلفیهازهاقبیلهویرایههشهویژگیه‌ههها‌یهسههندهاقبههلهازهذخیرههسههاز‌ی،هتهیهه‌یهیههک
پشتیبانهازهسندهوهغیرههراهتنظیمهکنیم.ه

Load/Save: کادر تنظیمات 1.21شکل 
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کار با اسلید -  2 
طراحی یک اسلید اصلی- 2.1 

Page،هاسلید‌یهاستهکههبههاعنوانهنقطههشروعهبرا‌یهدیگرهاسلید‌هاهاستفادههمیههشود.هایهنهاسههلیدهشهبیهه1اسلیدهاصلی

StyleهدرهنرمهافزارهWriterلی لیدهاص کهاس ،هفرمتهپایههبرا‌یه‌همهه‌یهاسلید‌هاهراهکنترلهمیهکند.هیکهارائههمیهتواندهبیشترهازهی
داشتههباشد.ه

مجمواعهها‌یهازهویژگیه‌هاهراهکههشههاملهرنههگهپسهزمینههه،هگرافیههکهیههاهاشههیاءهمتحههرکه(ماننههدهلوگههو،هخطههوطهتزیینههی،هو
گرافیکه‌ها‌یهدیگر)هدرهپسهزمینههوهسرهصفحههوهپاهصفحه،هاقرارگرفتنهوهانههدازههفههونتهمتههنهوهاقالبهبنههد‌یهمتههنهاسههت،هتعریههف

میهکند.ه
تمامهاینهویژگیه‌هاهدرهاسلیدهاصلیهباهطرحه‌هاهکنترلهمیههشوند.هبههاعبارتهدیگر،هطرحه‌ها‌یهالگو‌یهاسلیدهموجوده‌هسههتندهو
برا‌یهتمامهاسلید‌هاییهکههازهاینهالگو‌یهاسلیدهساختههشدههاند،هاجراهمیههشود.هتغییرهدادنهنتیجههطرحهدرهالگههو‌یهاسههلیدهبهرا‌ی

تغییرهدره‌همههاسلید‌ها‌یهاولیه.هاگرهچهههاینهتغییرهبرا‌یه‌هرهاسلیدهمنحصرهبفردهبدونهتأثیرهالگو‌یهاسلیدهامکانهدارد.ه
الگو‌یهاسلیدهدوهنوعهطرحهداردهکههباهآنه‌همراههاست:هطرحه‌ها‌یهارائههوهطرحه‌ها‌یهاعکههس.هسههبکهارائههههآمههادههمیههتوانههد
اصلحهشود.هاماهسبکه‌ها‌یهارائههجدیدهنمیهتواندهساختههشود.هبرا‌یهسبکه‌ها‌یهاعکس،هماهمیهتههوانیمهطرحه‌ههها‌یهآمههادههراهتغییههر

هنشانهدادههایم.2.1شکلهدادههوه‌همچنینهههطرحه‌ها‌یهجدیدهبسازیم،ه‌همانطورهکههدره

1 Slide Master
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انتخاب یک اسلید اصلی - 2.1.1 
لید‌هاهدرهimpressنرمهافزار نهاس لیهراهدارد.های متهSidebarهمجمواعهها‌یهازهاسلید‌ها‌یهاص Masterهوهدرهاقس  Pages

اینهاقسمتهسههزیرهمجمواعههدارد:ه ،Used in This Presentationنشانهدادههمیههشود.ه وهRecently Usedه Available for،ه

Useا‌ی ورتهاعکسه‌ه .هبرهرو‌یهنشانگرهبازهشدنهکههدرهکنارهنامهزیرهمجمواعههاقرارهدارد،هکلیکهکردههتاهبازهشودهوهاسلید‌هاهراهبص
کوچکیهنمایشهمیهد‌هیم،هیاهبرهرو‌یهنشانگرهجمعهشدنهکلیکهمیهکنیمهتاهسربرگهجمعهشدههوهاعکسه‌ها‌یهکوچکهمخفیهشوند،

هنشانهدادههایم.2.2شکله‌همانطورهکههدره

: نمایش اسلیدهای اصلی2.1شکل 
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تعیین قلم عنوان و متن - 2.1.2 
برا‌یهتعیینهاقلمهاعنوانهمتن،هابتداهدرهصفحهه(اسلید)هبرهرو‌یهمتنهاعنوانهکلیکهمیهکنیمهتاهدرهحالتهانتخابهاقرارهبگیرد

Editسپسهبرهرو‌یهمتنهانتخابهشدههراستهکلیکهمیهکنیمهوهازهمنو‌یهزمینهها‌یهکههبههازهمیهشههودهگههزینهه‌یه  Styleاب هراهانتخ
ر‌یFontمیهکنیمهتاهکادرهمحاورهها‌یهویرایشهسبکهبازهشودهوهازهسربرگه همیهتوانهنوعهاقلمهاعنوانهراهتغییرهداد.هسربرگه‌ها‌یهدیگ

درهاینهکادرهمحاورهها‌یهاستهکههباهاستفادههازهآنه‌هاهمیهتوانیمهتغییراتهدلخواههراهدرهاعنوانهانجامهد‌هیم.ه

Master Pages: پنل 2.2شکل 
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ایجاد اسلید جدید - 2.2 
ایجاد یک اسلید- 2.2.1 

هNewSlideهوهانتخابهگزینهه‌یهSlidePaneباهراستهکلیکهکردنهبرهرو‌یهاسلیدهفعلیهدرهپنجرهه‌یهنمایشهاسلید‌هاه
زارSlideاسلیدهجدید‌یهدرهاینهپنجرههوهدرهفضا‌یهکار‌یهظا‌هرهمیهشود.ه‌همهچنینهمیهتوانهبههرهرو‌یهآیکههونه وارهاب هدرهن

Presentation.هکلیکهکردههوهاسلیدهدلخواههراهدرجهنمود
<Insertبههروشهدیگرهنیزهمیهتوانیمهبههمسیره  Slideانطور م،ه‌هم هبرویمهوهاسلیدهموردهنظرهراهدرهفضا‌یهکار‌یهاقرارهد‌هی

هنشانهدادههایم.2.3شکلهکههدرهه

ایجاد یک اسلید از ویزارد- 2.2.2 
2.4شکلههاستفادههنماییم،ه‌همانطورهکههدرهFile→ Wizards→ Presentationبرا‌یهایجادهیکهفایلهارائههمیهتوانیمهازه

نشانهدادههایم.

: ایجاد یک اسلید جدید2.3شکل 
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ویرایش اسلید- 2.3 
انتخاب طرح اسلید- 2.3.1 

هراPropertiesماهمیهتوانیمهبرا‌یه‌هرهاسلیدهطرحیهدلخواههوهباهتوجههبههنیازمانهانتخابهنماییم.هبرا‌یهاینهکههار،هگههزینهه‌یه
ازهنوارهابزارهکنار‌یهانتخابهمیهکنیمهتاهطرحه‌ها‌یهمختلفهاسلیدهنمایشهدادههشوند.هیکیهازهطرحه‌هاهراهانتخابهمیهکنیمهکههههایههن

هنشانهدادههایم.2.5شکلهطرحهاسلیدهدرهفضا‌یهکار‌یهنمایشهدادههمیهشود،ه‌همانطورهکههدره

 ایجاد یک فایل ارائهWizard: 2.4شکل 
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کپی، انتقال و حذف اسلید- 2.3.2 
واقعیتCopyبرا‌یهکپیهکردنهیکهاسلید،هبرهرو‌یهآنهراستهکلیکهکردههوهگزینهه‌یه ههم هراهانتخابهمیهکنیمهوهسپسهب

هاستفادههکنیم.Ctrl+cهمیهنماییم.هدرهاعملیاتهکپیهمیهتوانیمهازهکلیدهمیانبرهPasteدلخواههرفتههوهاسلیدهراهدرهآنجاه
همیهباشد.Ctrl+ vهنیزهPasteکلیدهمیانبره

‌همچنینهمیهتوانیمهاسلید‌هاهراهبههمکانهدلخواههانتقالهد‌هیم.هبرا‌یهانجامهاینهکههارهمطههابقهاقبههل،هاسههلیدهمههوردهنظههرهرا
انتخابهکردههوهآنهراهبههکمکهماوسهبههمحلهدلخواههکشیدههوهر‌هاهمیهکنیم.

Deleteاسلید‌هاهراهباهراستهکلیکهکردنهبرهرو‌یهآنه‌هاهدرهاقسمتهپنجرهه‌یهنمایشهاسههلیدهوهانتخههابهگههزینهه‌یه  Slide

حذفهمیهکنیم.

: کادر صفحه بندی اسلید2.5شکل 
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جابجایی اسلیدها در سند - 2.3.3 
براه‌یهجابجاییهاسلید‌هاهدرهسندهاسلیدهدلخواههراهانتخابهکردههوهآنهراهبههمکانهموردهنظرهکشیدههوهر‌هههاهمیهکنیههم.هاگههر

اCtrlبخوا‌هیمهدرهیکهسندهچندهاسلیدهراهباه‌همهجابجاهکنیم،هدرهزمانهکلیکهبرهرو‌یهاسلید‌هاهدکمهه‌یه هراهپایینهنگههمیهداریمهت
چندهاسلیدهباه‌همهانتخابهشوندهوهتغییراتهبرهرو‌یهاسلید‌ها‌یهانتخابیهااعمالهمیهگردد.

تغییر طرح اسلید - 2.3.4 
برا‌یهتغییرهدادنهطرحهیکهاسلید،هابتداهاسلیدهموردهنظرهراهانتخابهکردههوهمراحلهزیرهراهاجراهمیههد‌هیم:

برهرو‌یهآنهراستهکلیکهمیهکنیم..1
هراهانتخابهمیهکنیم.Page Layoutسپسهازهمنو‌یهزمینهها‌یهکههبازهمیهشودهگزینهه‌یه.2
رحLayoutsازهپنله.3 اهط مهت هکههدرهسمتهراستهپنجرهه‌یهاصلیهنمایشهدادههمیهشودهیکیهازهطرحه‌هاهراهانتخابهمیهکنی

اسلیدهتغییرهکند.

مدیریت اسلید اصلی- 2.4 
ویرایش اسلید اصلی- 2.4.1 

ماهمیهتوانیمهالگو‌یهاسلیدمانهراهویرایشهکنیم.هبرا‌یهاینهکارهمراحلهزیرهراهانجامهمیهد‌هیم:
هرفتههتاهصفحهه‌یهاسلیدهاصلیهبازهشود.View → Master → Slide Masterبههمسیره.1
هراهانتخابهمیهنماییم.Master Pagesازهمنو‌یهسمتهراستهصفحههنمایش،هپنله.2
هاضافههمیهشود.SidebarهآنهصفحههدرهاقسمتMaster Pagesباهکلیکهبرهرو‌یه‌هرهصفحههدره.3
باهانتخابه‌هرهصفحههاقادرهخوا‌هیمهبودهآنهاسلیدهاصلیهراهویرایشهکنیم..4

ایجاد اسلید اصلی جدید - 2.4.2 
برا‌یهایجادهاسلیدهاصلیهجدیدهمراحلهزیرهراهانجامهمیهد‌هیم:

بههاقسمتهنمایشهاسلیده‌هاهاصلیهمیهرویم..1
برهرو‌یهالگو‌یهاسلیدهفعلیهراستهکلیکهمیهکنیم..2
هراهانتخابهمیهکنیم.New Masterازهمنو‌یهزمینهها‌یهکههبازهمیهشود،هگزینهه‌یه.3
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اسلیدهاصلیهجدیدهراهبههدلخواههطراحیهمیهکنیم..4

افزودن عناصر پویا - 2.4.3 
درهاسلیدهاصلیهاقسمته‌هاییهبرا‌یهدرجهتاریخهوهموضوعهوهشمارهه‌یهصفحههاقههرارهداردهکههههایههنهاقسههمته‌هاهمیهتواننههدهبههه

هراPlaceholdersهپنجرههView → Master → Master Elementsصورتهثابتهوهیاهمتغیرهباشند.هبرا‌یهمدیریتهآنه‌هاهازهمسیره
هنشههان2.6شکلهبازهمیهکنیمهوهمورد‌یهکههمدهنظرهاستهراهبرا‌یهدرجهیاهحذفهدرهصفحههانتخابهمیهکنیههم.ه‌همههانطورهکههههدره

دادههایم.

تغییرات در زمینه ‌ی اسلید - 2.5 
تغییر پس زمینه ‌ی اسلید - 2.5.1 

اگرهبخوا‌هیمهپسهزمینهه‌یهاسلید‌هاهراهتغییرهد‌هیم،هبایدهمراحلهزیرهراهانجامهد‌هیم:
هرفتههوهبرهرو‌یهاسلیدهدلخواههراستهکلیکهمیهکنیم.Slide Paneبههصفحهه‌یهنمایشهاسلیده

هراهانتخابهمیهکنیم.Slide Designازهمنو‌یهزمینهها‌یهکههبازهمیهشودهگزینهه‌یه
هبازهمیهشودهکههازهاینهکادرهمیهتوانیمهپسهزمینهه‌یهاسلیدهراSlide Designباهکلیکهبرهرو‌یهاینهگزینه،هکادرهمحاورهها‌یه

هنشانهدادههایم.2.7شکلهتغییرهد‌هیم.ه‌همانطورهکههدره

Placeholders: پنجره 2.6شکل 
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Setباهروشهدیگرهمیهتوانهدرهفضا‌یهکار‌یهبرهرو‌یهاسلیدهراستهکلیکهکردهوهازهمنو‌یهزمینههههگههزینهه‌یه  Background

Image  For  Slideاورهها‌ی ادرهمح نهک هراهانتخابهنمود.هباهکلیکهبرهرو‌یهاینهگزینههیکهکادرهمحاورهها‌یهبازهمیهشودهکههازهای
میهتوانهتصویر‌یهراهبرا‌یهپسهزمینهه‌یهاسلیدهانتخابهکرد.ه

اضافه کردن اشیاء به صفحه الگو - 2.5.2 
برا‌یهاضافههکردنهاشیاءهبههصفحههالگوهمراحلهزیرهراهانجامهمیهد‌هیم:

هواردهبخشهاسلید‌ها‌یهاصلیهمیهشویم.View → Master → Slide Masterابتداهازهمسیره.1
یکهاسلیدهاصلیهراهانتخابهمیهکنیم..2
درهصفحهه‌یهاسلیدهاصلیهشئها‌یهراهدرجهمیهکنیم..3

Slide Design: کادر محاوره ای 2.7شکل 
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همیهرویم.File>Tempelateحالهبرا‌یهاضافههکردنهاینهاسلیدهبههصفحههالگو،هبههمسیره.4
هراهانتخابهمیهکنیم.Save As Tempalateازهکادر‌یهکههبازهمیهشودهگزینهه‌یه.5
فحهsaveدرهکادرهمحاورهها‌یهبازهشدههرو‌یهگزینهه‌ی.6 هکلیکهمیهکنیمهتاهاسلیدهاصلیها‌یهکههایجادهکردههایمهبههاعنوانهص

الگوهذخیرههشود.

افزودن محتوا -  3 
درج متن - 3.1 
درج عنوان، زیر عنوان و متن - 3.1.1 

لاهنمایشه هانتخابNormal Viewبرا‌یهدرجهمتنهدرهجعبههمتنه‌ها‌یهساختههشدههابتداهاطمینانهحاصلهمیهکنیمهکههحتم
شدههباشد.ه

هکلیکهمیهکنیمهتاهمکانهنماهظا‌هرهشودClick to add TextهیاهClick to add Titleسپسهدرهجعبههمتنهبرهرو‌یهاعبارته
هنشانهدادههایم.3.1شکلهوهبتوانیمهدرهاینهجعبههمتن،هاعبارتهدلخواههراهتایپهکنیم.ه‌همانطورهکههدره
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ایجاد جعبه متن جدید- 3.1.2 
برا‌یهایجادهیکهجعبههمتنهجدیدهبههروشهزیرهاعملهمیهکنیم:
همیهرویم.View → Toolbars → Textبرا‌یهنمایشهنوارهابزارهجعبههمتنهدرهنوارمنو‌یهاصلیهبههمسیره

هکادرهمتنیهراهایجادهمیهکنیم.Tex Boxباهاستفادههازهابزاره
Fitباهاستفادههازهابزاره  Text  to  Frameههدر هکادرهمتنیهکههاقابلیتهپرهشدنهباهمتنهداردهراهایجادهمیهکنیم،ه‌همانطورهک

هنشانهدادههایم.3.2شکله

: نحوه درج متن در جعبه متن 3.1شکل 
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تغییر اندازه و انتقال جعبه متن- 3.1.3 
اندازهه‌یهجعبههمتنهازهطریقهدستگیرهه‌هاییهکههدرهاطرافهآنهاقرارهداردهتغییرهمیهکند،هبههصورتیهکههنشانگرهماوسهراهبههر

رو‌یهاینهدستگیرهه‌هاهاقرارهدادههوهمیهکشیمهتاهبههاندازهه‌یهدلخواههبرسیمهوهسپسهدکمهه‌یهماوسهراهر‌هاهمیهکنیم.
برا‌یهانتقالهجعبههمتنهنیزهابتداهآنهراهدرهحالتهانتخابهاقرارهدادههوهباهکشیدنهآنهبههمحههلهمهوردهنظههرهانتقههالهراهانجههام

میهد‌هیم.

تغییر خط، شیوه و رنگ جعبه متن- 3.1.4 
روش اول:

برا‌یهتغییرهخط،هشیوههوهرنگهجعبههمتنهبههروشهزیرهاعملهمیهکنیم:
هراهانتخابهمیهکنیم.AreaهیاهLineهابتداهبرهرو‌یهجعبههمتنهراستهکلیکهمیهکنیمهوهگزینهه‌یه•
یهتوانیمهتنظیماتهدلخواههراهانجامهد‌هیم.ه‌همههانطورهکههههدرهیکهکادرهمحاورهها‌یهبازهمیهشودهکههازهآنهکادرهمحاورهها‌یهم•

هنشانهدادههایم.3.3شکله

:  نوار ابزار جعبه متن3.2شکل 
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روش دوم:
هبرهرو‌یهاسلیدهموردهنظرهکلیکهکردههوهجعبههمتنهراهانتخابهمیهکنیم.

راتهلزمهراهازPropertiesرو‌یهآیکونه ودهوهتغیی هدرهنوارهابزارهکنار‌یهکلیکهمیهکنیمهتاهپنلهویژگیه‌ها‌یهجعبههمتنهبازهش
هنشانهدادههایم.3.4شکلهاینهپنجرههانجامهمیهد‌هیم.ه‌همانطورهکههدره

: کادر محاوره ای تغییر رنگ جعبه متن3.3شکل 
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درج نمودار- 3.2 
یکهنمودارهیکهتفسیرهگرافیکیهازهاطلاعاتهاستهکههشاملهیکهصفحههگستردهههمیهباشد.همههاهمیهتههوانیمهیههکهنمههودارهرا

کImpressهدرهارائههاقرارهدادههیاهازهابزارهدرجهنمودارهدرهنرمهافزارهOLEبههاعنوانهیکهشئه رارهدادنهی را‌یهاق اییم.هب هاستفادههنم
همراحلهزیرهراهانجامهمیهد‌هیم:Impressنمودارهباهاستفادههازهنرمهافزاره

: پنل ویژگی های جعبه3.4شکل 
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روش اول:
هنشانهدادههایم.3.5شکلههراهانتخابهمیهکنیم،ه‌همانطورهکههدرهInsert Chartدرهفضا‌یهکار‌یهنرمهافزارهآیکونه•

روش دوم:
هاقرارهداردStandardهکههدرهنوارابزارهChartهمیهرویمهیاهبرهرو‌یهآیکونهInsert > Chartدرهنوارهمنو‌یهاصلیهبههمسیره•

کلیکهمیهکنیم.هیکهنمودارهباهدادهه‌ها‌یهنمونههدرهاسلیدهایجادهمیهشود.
”هراهانتخابهمیهکنیم.Chart Typeبرا‌یهتغییرهنوعهنمودار،هگزینهه‌ی“•

: درج یک نمودار3.5شکل 
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‌همهچنینهبرا‌یهواردهکردنهدادههدرهجدول:
برهرو‌یهجدولهراستهکلیکهمیهکنیم.•
هراهانتخابهمیهکنیم.Chart Data Tableگزینهه‌یه•
هنشانهدادههایم.3.6شکلههدادهه‌هاهراهواردهمیهکنیم.ه‌همانطورهکههدرهData Tableدرهکادرهمحاورهها‌یه•

نوار ابزار نمودار - 3.2.1 
اقالبند‌یهنمودار‌هاهدرهنوارهابزارهاقالبند‌یهنمودارهاقراردارد.هبرا‌یهفعالهساز‌یهاینهنمودارهبعدهازهدابلهکلیکهبرهرو‌یهنمههودار

هفعالهمیهشود.هبرا‌یهغیرهفعالهکردنهاینهنوارهابزارهنیزهبهه‌همینهمسیرهرفتههوView → Toolbars → Formattingازههمسیره
هنشانهدادههایم.3.7شکلهاعلمتهاینهگزینههراهبرههمیهداریم.ه‌همانطورهکههدره

: داده های یک نمودار3.6شکل 
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ایجاد انواع نمودار - 3.2.2 
دادهه‌ها‌یهماهمیهتوانندهباهاستفادههازهانواعهمختلفهنمودار‌هاهارائههشوند.هاینهنرمهافزارهشاملهچندینهنوعهنمودارهاستهکههبه
ماهکمکهمیهکندهتاهپیامهراهبههمخاطبانهانتقالهد‌هیم.هبرا‌یهتغییرهنمودارهبایدهمطمئنهشویمهکههنمودارمانهانتخابهشههدههاسههت.

هنشانهدادههایم.3.8شکلههکلیکهمیهکنیم،ه‌همانطورهکههدرهChart Typeهبرهرو‌یهآیکونهFormattingدرهنوارابزاره

هراهازهمنو‌یChart Typeهرفتههیاهبرهرو‌یهنمودارهراستهکلیکهکردههوهFormat > Chart Typeیاهدرهنوارهمنو‌یهاصلیهبهه
هنشانهدادههایم.3.9شکلههبازهشود،ه‌همانطورهکههدرهChart Typeزمینههانتخابهمیهکنیمهتاهکادرهمحاورهها‌ی

: نوار ابزار قالبندی نمودار3.7شکل 

Chart Type: آیکون 3.8شکل 



هجزوهه‌یهآ‌موزشیه‌مهارتهکارهباهنرمهافزارهارائهه‌مطلب58

درهصورتیهکههانتخابهراهدرهلیستهسمتهچپهتغییرهد‌هیم،همثاله‌هههاییهازهنمهودارهدرهسهمتههراسههتهتغییهرهمیهکنهدهوهبها
انتخابه‌هرهکدامهمیهتوانیمهاثرهآنهراهدرهاسلیدهببینیم.هدرهصورتیهکههنوعهنمودارهراهتغییرهد‌هیم،هانتخابه‌ههها‌یهبعههد‌یهدرهسهمت
راستهدرهدسترسهاقرارهمیهگیرند.هبههرا‌یهمثههالهبعضههیهازهنمودار‌هههاهدارا‌یهانههواعهدوهبعههد‌یهوهسههههبعد‌یه‌هسههتندهوهزمههانیهکههه
نمودار‌ها‌یهسههبعد‌یهانتخابهشوند،هبیشترهگزینهه‌هاهبرا‌یهاشکالهانتخابیهدرهستونه‌هاهیاهمیلهه‌هههاه(نمههودارهمیلهها‌ی)هدرهدسههترس

Chart Typeهکلیکهمیههکنیم.هکادرهمحاورهها‌یOKاقرارهمیهگیرند.هویژگیه‌ها‌یهجدولیهکههمیهخوا‌هیمهراهانتخابهکردههوهبرهرو‌یه

بستههمیهشودهوهشماهبههپنجرهه‌یهویرایشهبازهمیهگردید،هدرهادامههنمونهها‌یهازهاینهنمودار‌هاهبیانهمیهشود.

نمودارهای ستونی 
نمودار‌ها‌یهستونیهدادهه‌هاییهراهکههنشانهد‌هندهه‌یهروندهدرهطولهزمانهاستهنشانهمیهد‌هدهوهاینهنوعهازهنمودارهدرهزمانی
کههنمودار‌یهدرهاسلیدهدرجهمیهشودهبههاعنوانهنمودارهپیشهفرضهاقرارهمیهگیرد.هدرهجاییهکههههتعههدادهنسههبتاهکمههیهازهدادهه‌ههها‌ی

Chart Type: کادر محاوره ای3.9شکل 
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نقطهها‌یهداریم،هاستفادههازهنمودارهستونیهتوصیههمیهشود.هاگرهکههماهیکهسر‌یهزمانیهبزرگهازهدادههراهداشتههباشیم،هاسههتفادههاز
نمودارهخطیهتوصیههمیهشود.ه

نمودارهای میله ای 
نمودار‌ها‌یهمیلهها‌یهنمایشهسریعیهازهدادهه‌ها‌یهمقایسهها‌یهکههزمانهدرهآنه‌هاهمهمهنیستهمیهد‌هد.هبرا‌یهمثههالهمقایسهههه‌ی

محبوبیتهمحصولتهدرهیکهبازار.ه

 نمودارهای دایره ای 
هنمودار‌ها‌یهدایرهها‌یهمقایسهها‌یهازهویژگیه‌هاهراهمیهد‌هد،هبراه‌یهمثال،ه‌هنگامهمقایسهه‌یهبخشه‌ها‌یهمختلفهصههرفهشههدههدر
آیتمه‌ها‌یهمختلفهیاهبخشه‌هاییهکههبطورهکلی.هاینهکاره‌هاهباهیکهمجمواعهه‌یهکوچکهازهمقداره‌هههاهبهههترینه‌هسهتند.هبهرا‌یهمثههال
ششهیاکمتر.هاستفادههکردنهازهمحدودههبزرگتر‌یهازهمقیاسه‌ها،هیکهتأثیرهدیدار‌یهازهیکهنمودارهدایههرهها‌یهدرهحههالهمحههوهشههدن

است.ه

نمودارهای منطقه 
نمودار‌ها‌یهمنطقههنسخهها‌یهازهنمودار‌ها‌یهخطهیاهستونهاست.هدرهزمانیهکههماهمیهخوا‌هیمهبههرا‌یهتاکیههدهحجههمهراهتغییههر
د‌هیم،هاستفادههازهآنه‌هاهمفیدهاست.هنمودار‌ها‌یهدیدار‌یهتأثیرهبیشتر‌یهازهیکهنمههودارهخطههیهدارنههدهامههاهنههوعهدادهها‌یهکههههشههما

استفادههمیهکنیدهبااعثهتفاوتهتأثیرهدیدار‌یهمیهشود.ه

نمودارهای خطی
نمودار‌ها‌یهخطیهسر‌یه‌ها‌یهزمانیهباهپیشرفته‌هستند.هکههبرا‌یهدادهه‌ها‌یهخامهایدههآلهوهبرا‌یهنموداره‌هاهباهروندهدادهه‌ها‌ی
نشانهدادههشدههیاهتغییراتهرو‌یهزمانهکههدرهآنهمیهخوا‌هیمهتأکیدهتداومهداشتههباشههد،همفیههده‌هسههتند.هدرهنمودار‌ههها‌یهخطههی،

هبرا‌یهنمایندگیهدادههسر‌یه‌ها‌یهزمانیهایدههآلهاست.هخطوطهسههبعد‌ی،هتماشاگرهراهگیجهمیهکند،هبنابراینهفقطهاستفادهXمحوره
ازهیکهخطهضخیمهترهیکهتصویرهدیدار‌یهبهتر‌یهراهمیهد‌هد.ه
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XYنمودارهای پراکنده یا

نمودار‌ها‌یهپراکندههبرا‌یهنمایشهدادهه‌هاییهکههشماهزمانیهبرا‌یهتجزیههوهتحلیلهآنهنداریدهمناسههبهاندهوهبههرا‌یهدادهه‌هههایی
کههمقدار‌یهاعدد‌یهبرا‌یهمقایسههاندهبهترینهگزینههاند.هبرا‌یهمثال:هدادهه‌یهآبهوه‌هوا،هواکنشه‌ها‌یهزیرهسطحهاسههیدیتهه‌یهمختلههف،

ت.Xشرایطهدرهارتفاعهیاهدادهه‌هاییهکههمنطبقهبرهدوهسر‌یهااعداده‌هستند.همحوره رهاس اهمتغی للهمستقلهازهپارامترهکنترلهی همعمو
(اغلبهیکهسر‌یهزمانی).ه

نمودارهای حبابی
ک نمودار‌ها‌یهحبابیهبرا‌یهنشانهدادنهسههمتغیرهاستفادههمیهشود.هدرهیکهنمودارهدکههارتیهمکهانهدوهمتغیهر،هازهمرکهزهی

حبابهشناساییهمیهشود.هتاهاینکههکههسومینهمتغیرهشعاعهحبابهراهنشانهمیهد‌هد.ه

نمودارهای خالص
نمودار‌ها‌یهخالصهشبیههبههنمودار‌ها‌یهاقطبیهوهراداره‌هستندهوهبرا‌یهمقایسهه‌یهدادهه‌هاهوهالبتههنههدرهبازهه‌یهزمههانیهمفیههد
هاز‌Yهستند،هاماهشرایطهمختلفهازهاقبیلهمتغیر‌هاهدرهیکهبازهه‌یهاعملیهراهنشانهمیهد‌هندهاقطبه‌هاهازهنمههودارهخههالص،همحور‌ههها‌یه

دیگرهنمودار‌هاهاست.هبههطورهکلیهبینهسههوه‌هشتهمحورهبهترینه‌هستند.ه‌هرهمقدارهبیشتر،هاینهنوعهنمودارهراهگیجهکنندههمیهکند.

نمودارهای دسته ای 
ودارهشههمعیهومیهتههوانیمهخطههوطهسههنتی،هنمههنمودار‌ها‌یهدستهها‌یهبههطورهویژهها‌یهمتخصصهنمودار‌ها‌یهستونهاست.هماه

نمودارهدوهستونیهراهانتخابهکنیم.هاطلاعاتهموردهنیازهبرا‌یهاینهنمودارهباهسر‌یه‌هاییهبرا‌یهبازهکردنهاقیمته‌ها،هبستنهاقیمته‌ههها،
هنشانهد‌هندهه‌یهیکهسر‌یهزمانیهاست.هXاقیمته‌ها‌یهبالهوهپایین.همحوره

نمودارهای خط و ستون
هنمودار‌ها‌یهخطهوهستونهترکیبیهازهدوهنوعهنمودارهدیگرهاست.هکههبرا‌یهترکیبهکردنهدوهدادهه‌یهمتمههایزهامههاهسههر‌یه‌ها‌ی

دادهه‌یهمرتبطهمفیدهاستهوهبرا‌یهمثالهفروشهدرهطولهزمانه(ستون)هوهروندهحاشیهه‌یهسوده(خط).ه
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افزودن مقادیر داده ها- 3.2.3 
نمودار‌یهکههبرا‌یهنمونههدرهیکهاسلیدهاقرارهمیهگیردهفقطهشاملهدوهاعنصرهاست:

هیکهدیوارهنموداره•
هیکهاعلیمهاختصار‌یهنمودار•

هماهمیهتوانیمهاعناصرهراهبههصورتهزیرهبههنمودارهاضافههکردههیاهازهآنهحذفهنماییم:ه
مطمئنهشویمهکههنمودارهانتخابهشدههوهدرهحالتهویرایشهاقرارهگرفتههاست.ه

ابInsertدرهنوارهمنو‌یهاصلیهبههاقسمته ودهراهانتخ افههش ودارهاض ههنم وا‌هیمهب ههمیهخ ر‌یهک هرفتههوهازهزیرهمنوهاعنص
هنشانهدادههایم.3.10شکلهمیهکنیم،ه‌همانطورهکههدره

ابDeleteبرا‌یهبرداشتنهاعنصرهازهیکهنمودار،هبرهرو‌یهاعنصرهراسههتهکلیکهکههردههوهگههزینهه‌یه ههانتخ و‌یهزمین هراهازهمن
هراهفشارهمیههد‌هیم.BackspaceهیاهDelمیهکنیم.هیاهکلیده

: علیم اختصاری نمودار3.10شکل 
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تنظیمات یک نمودار - 3.2.4 
برا‌یهانجامهتنظیماتهیکهنمودارهمراحلهزیرهراهانجامهمیهد‌هیم:

ابتداهبرهرو‌یهنمودارهکلیکهمیهکنیمهتاهدرهحالتهانتخابهاقرارهبگیرد.•
رهرو‌ی• وعهتنظیمهاتیهراهب سپسهبرهرو‌یهنمودارهراستهکلیکهکردههوهازهمنو‌یهزمینهها‌یهکههبازهمیهشودهمیهتوانیمه‌ههرهن

هنشانهدادههایم.3.11شکلهنمودارهانجامهد‌هیم،ه‌همانطورهکههدره

کار با تصویر - 3.3 
تصویرهبرا‌یهافزایشهوضوحهارائه،هسراعتهبخشیدن،هآسانهکردنهدریافتهوهدرکهمطلبهبرا‌یهمخاطبهاست.هنقههشهاطلع

: تنظیمات نمودار3.11شکل 
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رسانیهیکهتصویرهخوبهوهمناسبهمعادلهنقشهصد‌هاهکلمههخوا‌هدهبود.

نوار ابزار تصویر - 3.3.1 
هفعالهمیهکنیم.هدرهاینهنوارهابزارهگزینهه‌هاییView>Toolbars>Imageنوارهابزارهتصویرهراهمانندهدیگرهنوارهابزار‌هاهازهمسیره

وجودهداردهکههباهآنهمیهتوانهتصویرهراهویرایشهکردهوهبههآنهویژگیه‌ها‌یهمختلفیهداد.ه

وارد کردن تصاویر - 3.3.2 
هInsert>ImageهاستفادههمیهکنیمهیاهبههمسیرهImageبرا‌یهواردهکردنهیکهتصویرهازهآیکونه هرفتههوهازهکادرهمحاورهها‌یهک

بازهمیهشودهیکهتصویرهدلخواههراهدرهاسلیدهواردهمیهکنیم.ه

انتقال تصاویر - 3.3.3 
اگرهبخوا‌هیمهتصویر‌یهراهانتقالهد‌هیمهمراحلهزیرهراهانجامهمیهد‌هیم:

همیهرویم.File>Exportهتصویرهموردنظرهراهانتخابهکردههسپسهبههمسیر•
هکههبازهمیهشودهمکانیهکههمیهخوا‌هیمهفایلهدرهآنهمنتقلهشودهراهانتخابهمیهکنیم.Exportهازهکادرهمحاورهها‌یه•
هکلیکهمیهکنیم.هexportبرهرو‌یهگزینهه‌یه•

ترسیمات - 3.4 
نوار ابزار ترسیم - 3.4.1 

هفعالهمیهشود.هدرهاینهنوارهابزار،هابزار‌ها‌یهمختلفیهبرا‌یهویرایشهوView>ToolbarsهازهمسیرهDrawingنوارهابزارهترسیمه
تغییرهتصاویرهوهترسیماتهوجودهدارد.

: نوار ابزار تصویر 3.12شکل 
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اضافه کردن انواع خطوط و شکل ها‌ی هندسی - 3.4.2 
هاقرارهداردهاستفادههمیهکنیم.Drawing،هکههدرهنوارابزارهLineبرا‌یهاضافههکردنهانواعهخطوطهازهآیکونه

برا‌یهاضافههکردنهشکله‌ها‌یه‌هندسیهبستههبههشکلیهکههههمههدهنظرمههانهاسههت،هازهآیکونه‌ههها‌یهمتنههواعیهکههههدرهنههوارابزار
Drawing.هاقرارهدارد،هاستفادههمیهکنیم

هدرهاینهنوارهابزار،.هبرا‌یهااعمالهاثراتهمختلفهبههاینهترسیماتهمانندهچرخشهوهتغییرهزاویههو...هنیزهآیکونه‌ههها‌یهمتنههواعی
وجودهدارد.ه

ترسیم جعبه متن - 3.4.3 
ونهDrawingبرا‌یهترسیمهجعبههمتنهدرهنوارهابزاره ارهآیک ههدرهکن وچکیهک ثهک رهرو‌یهمثل کCallouts،هب تهکلی هاس

میهکنیمهوهیکیهازهجعبههمتنه‌ها‌یهموجودهراهانتخابهمیهکنیم.هباهانتخابهاینهجعبههمتن،همیهتوانیمهآنهراهبهه‌هرهمکانهدرهاسههلید
هنشانهدادههایم.3.13شکلهجابجاهکنیم،ه‌همانطورهکههدره

کار با اشیاء سه بعد‌ی - 3.4.4 
برا‌یهکارهباهاشیاءهسههبعد‌ی:ه

3Dهابتداهازهطریقهآیکونه•  ObjectهکههدرهنوارهابزارهDrawingورد لیدهم د‌یهراهدرهاس ههبع کلهس کهش هاست،هی

: نوار ابزار ترسیم3.13شکل 

: ترسیم جعبه متن3.14شکل 
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نظرمانهدرجهمیهکنیم.ه
هشکلهراهدرهحالتهانتخابهاقرارهمیهد‌هیمهتاهدستگیرهه‌ها‌یهانتخابیهدرهاطرافهشکلهظا‌هرهشوند.•
3Dهبرهرو‌یهشکلهراستهکلیکهمیهکنیمهوهازهمنههو‌یهزمینهها‌یهکهههظهها‌هرهمیهشههودهگهزینهه‌یه•  Effectاب هراهانتخ

میهکنیم.
3Dکادرهمحاورهها‌یه•  Effectه یاءهس ههاش واعیهراهب هبازهمیهشودهوهازهاینهکادرهمحاورهها‌یهمیهتوانیمهجلوهه‌ها‌یهمتن

هنشانهدادههایم.3.15شکلهبعدیمانهبد‌هیم،ه‌همانطورهکههدره

3D Effect: کادر محاوره ای 3.15شکل 
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درج جدول - 3.5 
جدوله‌هاهمکانیزمهاقو‌یها‌یهبرا‌یهانتقالهسریعهساختارهاطلاعاته‌هستند،هچونهآنه‌هاهدره‌هنگامهایجههادهارائههههابههزارهمهمیهههرا

لاهدره هایجادهکنیم.Impressنشانهمیههد‌هند.هماهمیهتوانیمهجداولهراهمستقیم

هموجودهمیههباشند.SidebarهازهTable Designچندینهگزینههازهپیشهتعیینهشدههدرهاقسمته
برا‌یهاقرارهدادنهجدولهدرهاسلید،هبههصورتهزیرهاعملهمیهکنیم:

اسلید‌یهکههشاملهجدولهاستهراهانتخابهمیهکنیم.•
درهصورتهلزومهسبکهاسلیدهراهبرا‌یهایجادهفضاهبرا‌یهجدولهتغییرهمیههد‌هیم.•
Insertهدرهنوارهمنو‌یهاصلی،هبهه•  >  Tableهرفتههیاهبرهرو‌یهآیکونهTableهدرهنوارابزارهStandardا هکلیکهمیهکنیمهت

هبازهشود.Insert Tableکادرهمحاورهها‌یه
هتعدادسطره‌هاهوهستونه‌هاییهراهکههبرا‌یهجدولهنیازهداریمهراهانتخابهمیهکنیم.•
ود،OKبرا‌یهبستنهکادرهمحاورهها‌یهبرهرو‌یهدکمهههه‌یه• ا‌هرهمیههش لیدمانهظ زهاس دولهدرهمرک ردههوهج کهک هکلی

هنشانهدادههایم.3.16شکله‌همانطورهکههدره

نوار ابزار جدول - 3.5.1 
نview>Toolbars>Tableنوارهابزارهجدولهازهمسیره هه‌همی زهب زارهنی وارهاب هفعالهمیهشود.هبرا‌یهغیرهفعالهکردنهاینهن

Insert Table: کادر محاوره ای 3.16شکل 



67جزوهه‌یهآ‌موزشیه‌مهارتهکارهباهنرمهافزارهارائهه‌مطلب

هنشانهدادههایم.3.17شکلهمسیرهرفتههوهاینهگزینههراهبیهاعلمتهکنیم،ه‌همانطورهکههدره

وارد کردن جدول - 3.5.2 
Insertدرجهجدولهدرهاسلید‌هاهباهرفتنهبههمسیره  >Tableونه رهرو‌یهآیک زارهTableهیاهکلیکهب وارهاب اStandardهازهن هی

طر‌هاCtrl+F12هوهیاهکلید‌ها‌یهمیانبرهTableاستفادههازهنوارهابزاره هامکانهپذیرهاست.هباه‌هرهکدامهازهاینهروشه‌هاهمیهتوانیمهتعدادهس
وهستونه‌ها‌یهجدولمانهراهانتخابهنماییم.ه

خصوصیات جدول - 3.5.3 
برا‌یهتنظیمهخصوصیاتهجدولهمراحلهزیرهراهانجامهمیهد‌هیم:

هابتداهجدولهموردهنظرهراهانتخابهکردههتاهدستگیرهه‌ها‌یهانتخابیهدرهاطرافهجدولهنمایشهدادههشوند.•
راهانتخابهمیهنماییم.Tableبرهرو‌یهجدولهراستهکلیکهکردههوهگزینهه‌یه•
کههبازهشدههاست،هتنظیماتهدلخواههراهانجامهمیهد‌هیم.هFormat cellsازهکادرهمحاورهها‌یه•
هنشانهدادههایم.3.18شکلههکلیکهمیهکنیمهتاهتغییراتهذخیرههگردد،ه‌همانطورهکههدرهokبرهرو‌یهدکمهه‌یه•

: نوار ابزار جدول3.17شکل 
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ویرایش و قالب بند‌ی-  4 
ویرایش اسلید- 4.1 

تعیین اندازه ‌ی اسلید - 4.1.1 
Formatبرا‌یهتعیینهاندازهه‌یه‌هرهاسلید،هبههمسیره  >  Page  Setupربرگهداردهاز اورهها‌یهدوهس همیهرویم.هاینهکادرهمح

‌هرکدامهازهسربرگه‌ها‌یهاینهکادرهمحاورهها‌یهمیهتوانهاندازهه‌یهاعرضهوهارتفههاعهاسههلیدهوهخصوصههیاتهدیگههرهآنهازهاقبیههلهحاشههیه،
هنشانهدادههایم.4.1شکلهتنظیماتهطرحهوهپسهزمینههراهتعیینهکرد،ه‌همانطورهکههدر

: تنظیم خصوصیات جدول3.18شکل 
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تغییر جهت اسلید- 4.1.2 
زینهه‌یPage Setupبرا‌یهتغییرهجهتهاسلیدهبصورتهافقیهیاهاعمههود‌ی،هازهکههادرهمحههاورهها‌ی اorientationهگ یهی ،هافق

اعمود‌یهبودنهاسلید‌هاهراهمشخصهمیهکنیم.

ویرایش متن - 4.2 
جستجو‌ی متن - 4.2.1 

هنشانهدادههایم.4.2شکلههاستفادههمیهکنیم.‌همانطورهکههدرهFindبرا‌یهجستجو‌یهیکهکلمه،هاعبارتهیاهمتن،هازهنوارهابزاره
یرView>Toolbars>Findهاینهنوارابزارهازهمسیره نهمس هه‌همی هفعالهمیهشود.هبرا‌یهغیرهفعالهکردنهاینهنوارهابزارهنیزهب

Page Setup: کادر محاوره ای 4.1شکل 
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رفتههوهاعلمتهاینهگزینههراهبرهمیهداریم.ه

جایگزینی متن، جابجایی متن، انتخاب متن - 4.2.2 
Findباهاستفادههازهکادرهمحاورهها‌یه  &  ReplaceهکههازهمسیرهEdit  >  Find  &  Replaceوانیم ود،همیهت هاجراهمیهش

هنشانهدادههایم.4.3شکلهواژهه‌ها‌یهموردهنظرهراهجایگزینهنماییم.‌همانطورهکههدر

قالب بند‌ی متن - 4.3 
تغییر نوع و اندازه ‌ی قلم - 4.3.1 

هاستفادههمیهکنیم.هباهاستفادههازهآیکونه‌ها‌یهاینهنوارهابزارهمیهتوانیمText Formattingبرا‌یهاقالبهبند‌یهمتنهازهنوارهابزاره

Find: نوار ابزار 4.2شکل 

 Find & Replace: کادر محاوره ای 4.3شکل 
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هنشانهدادههایم.4.4شکلهنوعهوهاندازهه‌یهاقلمهوهغیرههراهتغییرهد‌هیم.ه‌همانطورهکههدره

مورب کردن، برجسته کردن، زیر خط دار کردن و تغییر حالت حروف در متن - 4.3.2 
وارIبرا‌یهایتالیکهکردنهمتن،همتنهموردهنظرهراهانتخابهکردههوهبرهرو‌یهآیکونایتالیک کردن (کج کردن):  هکههدرهن

یرهFormattingابزاره ود،هازهمس الهنب زارهفع الview>toolbars>formattingهاقرارهدارد،هکلیکهمیهکنیم.هاگرهنوارهاب هآنهراهفع
میهکنیم.ه

زارBه:هبرا‌یهبرجستههکردنهمتن،همتنهموردهنظههرهراهانتخههابهکههردههوهبههرهرو‌یهآیکههونبرجسته کردن وارهاب ههدرهن هک
Formatting.هاقرارهدارد،هکلیکهمیهکنیم

زارUبرا‌یهزیرهخطهدارهکردنهمتن،همتنهموردهنظرهراهانتخابهکردههوهبرهرو‌یهآیکونهزیر خط دار کردن:  وارهاب هکههدرهن
Formatting.هاقرارهدارد،هکلیکهمیهکنیم

بههرا‌یهتغییههرهحههالتهحههروفهدرهمتههن،همتههنهمههوردهنظههرهراهانتخههابهکههردههوهازهمسههیرتغییر حالت حروف در متن: 
Format>changing case.هحالتهمتنهراهتغییرهمیهد‌هیم

سایه دار کردن حروف- 4.3.3 
درهبسیار‌یهازهمواردهبههدلیلهداشتنهزمینهها‌یهباهرنگهمتفاوتهمتنهداخلهاسلیدهبههخوبیهدیدههنمیهشودهبهه‌همینهدلیل

هدرهنوارابزارهاقالبهبند‌یهاستفادههمیهکنیم.هنهازهدکمهازهسایههبرا‌یهمتنهاستفادههمیهشودهبرا‌یهسایههدارهکردنهمت

تغییر موقعیت متن - 4.3.4 
اورهها‌یPositionبرا‌یهتغییرهدادنهمکانهوهمواقعیتهمتن،همتنهمههوردهنظههرهراهانتخههابهکههردههوهازهسههربرگه ادرهمح هدرهک

Format → Character.هاستفادههمیهکنیم
گزینهه‌ها‌یهاینهبخشهاعبارتهاندهاز:

هاستفادههمیهکنیم.subscriptهوهبرا‌یهپایینهنویسه(اندیس)هشدنهمتنهازهsuperscriptبرا‌یهبالنویسهشدنهمتنهازه•

Text Formatting: نوار ابزار 4.4شکل 



هجزوهه‌یهآ‌موزشیه‌مهارتهکارهباهنرمهافزارهارائهه‌مطلب72

Raise/lowerنکته:هباهگزینهه  byر م.هاگ نهمیهکنی همقدارهدرصد‌یهکههبایدهمتنهبههبالهیاهپایینههتغییرهمکانهد‌هدهراهتعیی
گزینهه‌یهاتوماتیکهانتخابهشود،هاینهگزینههغیرهفعالهخوا‌هدهشد.ه

Relativeگزینهه•  Font  Sizeخص ههمش هدرصد‌یهازهکاراکتر‌ها‌یهاستفادههشدههراهنسبتهبههاندازهه‌یهکاراکتر‌ها‌یهاولی
میهکند.

•Scale  widthردن ردههک اهفش یهی یدنهافق یلهه‌یهکش همقیاسهاعرضهدرهچرخشه–هدرصد‌یهازهپهنا‌یهفونتهراهبههوس
کاراکتره‌ها‌یهمنحصرهبههفردهدرهمتنهانتخابهشدههمشخصهمیههکند.

•Spacingهفاصلههگذار‌یه–هبرا‌یهگسترشهدادنهیاهفشردههکردنهفاصلهه‌هاهبینهکاراکتره‌هاهراهدرهمتنهانتخابهشدههمشخص
میههکند.ه

•Default.ه(پیشهفرض)هازهفاصلههگذار‌یههکاراکترهمشخصهشدههدرهنوعهفونتهاستفادههمیههکند
•Expanded.ه(گسترشهدادن)هفاصلهه‌یهبینهکاراکتره‌هاهراهافزایشهمیههد‌هد
•Condensed.ه(فشردههساز‌ی)هفاصلهه‌یهبینهکاراکتره‌هاهراهکا‌هشهمیههد‌هد
Pairگزینهه•  kerningم د.هتنظی مهمیههکن هبههطورهاتوماتیکهفاصلهه‌یهبینهکاراکتره‌هاهراهبرا‌یهترکیبهکردنهحروفهتنظی

فاصلههفقطهبرا‌یهنوعه‌ها‌یهفونتهاصلیهموجودهاستهوهاینهگزینههبههپشتیبانیهپرینترهشماهنیههازهدارد،ه‌همههانطورهکههههدر
هنشانهدادههایم.4.5شکله
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تغییر رنگ متن - 4.3.5 
Fontبرا‌یهتغییرهدادنهرنگهمتن،هابتداهمتنهموردهنظرهراهانتخابهمیهکنیمهوهسپسهازهطریقهآیکونه  Colorوار ههدرهن هک

هاقرارهدارد،هرنگهمتنهراهتغییرهمیهد‌هیم.هText Formattingابزاره

تنظیم چیدمان متن و فاصله ‌ی بین خطوط- 4.3.6 
منظورهازهچیدمانهمتنهراستهچینهوهچپهچینهکردنهوهترازهبند‌یهمتنهاستهکههبرا‌یهاینهکههارهدرهنههوارهمنههو‌یهاصههلی،

Format > Paragraphهراهانتخابهمیهکنیمهتاهکادرهمحاورهها‌یهParagraphهنشانهدادههایم.4.6شکلههبازهشود.‌همانطورهکههدر

Position: سربرگ 4.5شکل 
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همواردهزیرهاقابلهتنظیمهمیهباشد.paragraphدرهزبانههتوهرفتگیهوهفاصلههگذار‌یهکادرهمحاورهها‌یه
Indent.ه(توهرفتگی)همقدارهفاصلهها‌یهکههبینهسمتهچپهوهراستهحاشیههوهپاراگرافهر‌هاهمیهشودهراهنشانهمیههد‌هد

Before  Textد،هوارد تههباش ه(اقبلهازهمتن)مقدارهفاصلهها‌یهراهکههمیهخوا‌هیمهپاراگرافهازهحاشیهه‌یهصفحههتوهرفتگیهداش
میهکنیم.هاگرهبخوا‌هیمهکههپاراگرافهراهبههسمتهحاشیهه‌یهصفحههنزدیکهکنیههم،هااعههدادمنفیهراهواردهمیهکنیههم.هدرهزبانه‌ههها‌یهاز
چپهبههراست،هلبهه‌یهسمتهچپهپاراگرافهباهتوجههبههحاشیهه‌یهسمتهچپهصفحههتوهرفتههمیهشود.هدرهزبانه‌ها‌یهراستهبههچهپ،

لبهه‌یهسمتهراستهپاراگرافهباهتوجههبههحاشیهه‌یهسمتهراستهتوهرفتههمیههشود.ه
After  Textد،هوارد تههباش یهداش وهرفتگ فحههت یهه‌یهص ه(بعدهازهمتن)همقدارهفاصلهها‌یهکههمیهخوا‌هیمهپاراگرافهازهحاش

میهکنیم.هاگرهبخوا‌هیمهکههپاراگرافهراهبههسمتهحاشیهه‌یهصفحههنزدیکهکنیم،هااعدادهمنفههیهراهواردهمیهکنیههم.هدرهزبانه‌ههها‌یهاز

Paragraph: کادر محاوره ای 4.6شکل 
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چپهبههراست،هلبهه‌یهسمتهراستهپاراگرافهباهتوجههبههحاشیهه‌یهسمتهراستهصفحههتوهرفتههمیهشود.هدرهزبانه‌ههها‌یهراسههتهبههه
چپ،هلبهه‌یهسمتهراستهپاراگرافهباهتوجههبههحاشیهه‌یهسمتهراستهتوهرفتههمیههشود.ه

First line.ه(خطهاول)هسطرهاوله‌هرهپاراگرافهبههاندازهه‌یهمقدار‌یهکههواردهکنیمهتورفتههمیههشود
Spacingه(فاصلههگذار‌ی)همقدارهفاصلهها‌یهراهکههبینهپاراگرافه‌ها‌یهانتخابهشدههر‌هاهمیهشودهنشانهمیههد‌هد.ه

Above  paragraph،ود اهش ه(بال‌یهپاراگراف)همقدارهفاصلهها‌یهراهکههمیهخوا‌هیمهدرهبال‌یهپاراگرافه‌ها‌یهانتخابهشدههر‌ه
واردهمیههکنیم.ه

Below  paragraphود،هوارد اهش ه(زیرهپاراگراف)همقدارهفاصلهها‌یهکههمیهخوا‌هیمهدرهپایینهپاراگرافه‌ها‌یهانتخابهشدههر‌ه
میههکنیم.

Line  spacingخص ودهراهمش اهمیهش اراگرافهر‌ه رهپ ه(فاصلههگذار‌یهخط)همقدارهفاصلهها‌یهکههبینهخطوطهازهمتنهدره‌ه
میههکند.هگزینهه‌ها‌یهموجودهدرهلیستهکشوییهبصورتهزیرهاست:

Singleه(خطهتنها)هفاصلهه‌یهخطهتنهاهدرهپاراگرافه‌هاهااعمالهمیههشود.ه
linesمیههکند.هدرهخطهیکهوهنیمهتنظیمهه(خطه‌ها)هفاصلهه‌یهخطه‌هاهرا

Double.هفاصلهه‌یهخطه‌هاهراهدرهدوهخطهتنظیمهمیههکند
Proportionalهه اییهک %همربههوطهبههه100ه(متناسب)هاینهگزینههراهانتخابهکردههوهسپسهمقدارهدرصد‌یهراهدرهجعبه،هج

فاصلهه‌یهخطهتکیهاست،هواردهمیهکنیم.ه
At  Leastه کهب ه(حدااقل)هاگرهازهاندازهه‌ها‌یهمختلفهفونتهدرهیکهپاراگرافهاستفادههکنیم،هفاصلهه‌یهخطوطهبطورهاتوماتی

بزرگترینهاندازهه‌یهفونتهتنظیمهمیهشوند.هاگرهترجیحهد‌هیمهکههفاصلهه‌یهیکسانهبرا‌یه‌همهه‌یهخطوطهداشتههباشههیم،همقههدار‌یهرا
همشخصمیهکنیمهکههمربوطهبههبزرگترینهاندازهه‌یهفونتهاست.هAt Leastدره

Leading.ه(برجستههکردن)هارتفاعهفضا‌یهاعمود‌یهکههبینهدوهخطهاقرارهداردهراتنظیمهمیههکند
Fixedه(ثابتهکردن)هیکهمقدارهثابتهراهبرا‌یهفاصلهه‌یهبینهخطوطهواردهمیهکنیم.ه

4.7شکلههبرا‌یهمشخصهکردنهترازبند‌یهپاراگرافهبههصورتهزیرهاستفادههمیهکنیههم.‌همههانطورهکههههدردرهزبانههترازبند‌ی
نشانهدادههایم.
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Leftه نهگزین د،های الهباش ه(چپ)هپاراگرافهراهازهحاشیهه‌یهسمتهچپهصفحههترازهمیههکند.هاگرهپشتیبانیهزبانهآسیاییهفع
Left/Topهنامیدههمیههشود.ه

Rightن د،های الهباش یاییهفع انهآس ه(راست)هپاراگرافهراهازهحاشیهه‌یهسمتهراستهصفحههترازهمیههکند.هاگرهپشتیبانیهزب
هنامیدههمیههشود.هRight/Bottomگزینهه

Centered.ه(مرکز)همحتویاتهپاراگرافهراهدرهمرکزهصفحههاقرارهمیههد‌هد
Justify.ه(‌همهترازهکردن)هپاراگرافهراهازهسمتهراستهوهچپهحاشیهه‌یهصفحههترازهمیهکند

: زبانه ترازبندی4.7شکل 
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Text direction)ه(جهتهمتن)هجهتهمتنهراهبرا‌یهپاراگرافیهکههازاقالبهبند‌یهمتنه‌ها‌یهپیشرفتههCTL،هاستفادههمیههکند(
مشخصهمیههکندهوهفقطهدرهزمانیهموجودهاستهکههاقالبهبند‌یهمتنه‌ها‌یهپیشرفتههپشتیبانیهشدههباشد.ه

ویرایش و قالب بند‌ی نمودار - 4.4 
برا‌یهویرایشهکردنهوهاقالبهبند‌یه‌هرهبخشهازهنمودارمراحلهزیرهراهانجامهمیهد‌هیم:

هاقسمتیهازهنمودارهکههمدهنظرمانهاستهراهانتخابهمیهکنیم.•
Format،هرو‌یهگزینهه‌یFormattingهازهنوارهمنو‌ی•  Selectionاز اتهب هکلیکهمیهکنیمهتاهکادرهمحاورهها‌یهتنظیم

شود.
هازهاینهکادرهمحاورهها‌یهگزینهه‌ها‌یهدلخواههراهانتخابهمیهکنیم.•
هکلیکهمیهکنیمهتاهتغییراتهذخیرههگردد.okبرهرو‌یهدکمهه‌یه•
باهاستفادههازهاینهکادرهمیهتوانیمهاقالبهبند‌یهدلخواههراهانجامهد‌هیم.•

اصلح یک نمودار - 4.4.1 
Chartاگرهبرهرو‌یهنمودارهراستهکلیههکهکههردههوهگههزینهه‌ی  Typeر ودارهراهتغیی وعهنم وانیمهن م،همیهت ابهکنی هراهانتخ

هنشانهدادههایم.4.8شکلهد‌هیم.‌همانطورهکههدر



هجزوهه‌یهآ‌موزشیه‌مهارتهکارهباهنرمهافزارهارائهه‌مطلب78

تغییر رنگ پس زمینه ‌ی نمودار - 4.4.2 
هنشانهدادههایمهبههروشهزیرهاعملهمیهکنیم:4.9شکلهبرا‌یهتغییرهفضا‌یهاطرافهیکهنمودارهگرافیکیه‌همانطورهکههدر

هبرهرو‌یهنمودارهدوهبارهکلیکهمیهکنیمهتاهدرهحالتهویرایشهاقرارهگیرد.•
Formatهدرهنوارهمنو‌یهاصلیهبهه•  >  Format  Selectionمیهرویم،هیاهبرهرو‌یهفضا‌یهنمودارهراسههتهکلیکهکههردههو

Format Chart Area.هراهانتخابهمیهکنیم
Chartهکادرهمحاورهها‌یه•  Areaهبازهمیهشود.هزبانههAreaا ا‌یهفض هراهانتخابهمیهکنیمهتاهصفحهها‌یهکههشاملهگزینهه‌ه

است،هبازهشود.
دهFillهازهلیستهکشوییه• ابهش ردنهانتخ هنوعهپسهزمینههراهانتخابهمیهکنیم.هگزینهه‌ها‌یهموجودهبستههبههنوعهپرهک

تغییرهمیهکند.
هکلیکهمیهکنیمهتاهکادرهمحاورهها‌یهبستههشدههوهتغییراتهااعمالهگردد.OKبرهرو‌یه•

Chart Type: کادر 4.8شکل 
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تغییر رنگ بخش ها‌ی نمودار - 4.4.3 
برا‌یهتغییرهرنگهبخشه‌ها‌یهنمودارمراحلهزیرهراهانجامهمیهد‌هیم:

هابتداهبخشهموردهنظرهراهانتخابهمیهکنیم.•
.ه..هراهانتخابهمیهکنیم.formatهسپسهبرهرو‌یهآنهراستهکلیکهکردههوهازهمنو‌یهبازهشدههگزینهه‌ی•
درهکادرهمحاورهها‌یهبازهشدههوهزبانههمناسبهراهانتخابهوهتنظیماتهراهانجامهمیهد‌هیم.•

Chart Area: کادر محاوره ای 4.9شکل 
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قالب بند‌ی تصاویر - 4.5 
توانایی برش و تغییر اندازه ‌ی تصاویر - 4.5.1 

برا‌یهتغییرهاندازهه‌یهاشیاءهگرافیکیهباهاستفادههازهماوس:
هبرهرو‌یهشئهگرافیکیهیاهگرو‌هیهازهاشیاءهگرافیکیهکلیکهمیهکنیمهتاهدستگیرهه‌ها‌یهانتخابیهنمایشهدادههشوند.•
اشارههگرهراهبرهرو‌یهیکیهازهدستگیرهه‌ها‌یهانتخابیهاقرارهمیهد‌هیم.•
سپسهتغییراتهدلخواههراهانجامهمیهد‌هیم.•

همیهرویمهوهازهکادرFormat > Position and Sizeبرا‌یهتغییرهاندازهه‌یهداقیقهترهشئهگرافیکی،هدرهنوارهمنو‌یهاصلیهبهه
هنشانهدادههایم.4.10شکلههاستفادههمیهکنیم.ه‌همانطورهکههدرPosition and Sizeمحاورهها‌یه

Position and Size: کادر محاوره ای 4.10شکل 
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اع،Sizeحاله‌هرهدوهمقدارهاعرضهوهیاهارتفاعهشئهراهدرهاقسمته رضهوهارتف نهاع بهبی ظهتناس را‌یهحف هتغییرهمیهد‌هیم،هب
Keepگزینهه‌یه  ratioهه انیهک د.هزم Keepهراهاقبلهازهتعیینهکردنه‌هرهمقدار‌یهانتخابهکنی  ratioرات د،هدرهتغیی ابهش هانتخ

اتوماتیک،هنتایجهراهبههیکهبعدهتغییرهمیهد‌هدهوهبرا‌یهدیگرهتغییرات،هنسبتهبینهاعرضهوهارتفاعهنگههداشتههمیهشود.

چرخش و تغییر زاویه - 4.5.2 
برا‌یهچرخشهیکهتصویرهمراحلهزیرهراهانجامهمیهد‌هیم:

تصویرهموردهنظرهراهانتخابهمیهکنیم..1
هانتخابهمیهکنیم.Imageآیکونهچرخشهوهتغییرهزاویهه‌یهتصاویرهراهازهنوارابزاره.2
هنشههان4.11شکلهباهاستفادههازهدستگیرهه‌ها‌یهاقرمزهرنگهتصویرهراهبههاندازههدلخههواههمیهچرخههانیم.ه‌همههانطورهکههههدره.3

دادههایم،

تغییر خصوصیات تصاویر- 4.5.3 

شImageبرا‌یهاقالبهبند‌یهتصاویرهازهنوارابزاره را‌یهویرای اد‌یهب ا‌یهزی زارههاقابلیته‌ه هاستفادههمیهکنیمهکههدرهاینهنوارهاب
تصویرهوجودهدارد،هدرهادامههبخشیهازهاینهاقابلیته‌هاهمعرفیهمیهشود.

فیلتر
هکلیکهمیهکنیمهتاهفیلتر‌ها‌یهگرافیکیهمختلفیهکههموجوده‌هستندهنمایشهدادههشوند.Filterبرهرو‌یهآیکونه

Image: نوارابزار 4.12شکل 

: آیکون چرخش4.11شکل 
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فیلتر‌یهکههمیهههخوا‌هیمهااعمالهشودهراهانتخابهمیهنماییم.هبرا‌یهنمایشهنامهفیلههتر،همکانهنمههاهههراهرو‌یهآیکههونهنگههداشههتههو
منتظرهمیهشویمهتاهابزارهظا‌هرهشوند.

اثرنام آیکون

معکوسهکردن
مقدارهرنگهازهیکهتصویرهرنگهیاهمقدارهروشناییهازهیکهتصویرهسایههدارهراهمعکوس

ررهفیلترهراهدوبارههااعمالهکنید. میهکند.هبرا‌یهبرگرداندنهاث

تصویرهراهباهاستفادههازهااعمالهیکهفیلترهپایینهصافهیاهتارهمیهکند.صافهکردن

هتصویرهراهباهااعمالهیکهفیلترهبالهگذرهتیزهمیهکند.تیزهکردن

باهااعمالهیکهفیلترهمیانههخشهراهحذفهمیهکند.حذفهخش

درهمعرضهآفتاب
اقرارهدادن

یکهکادرهمحاورهها‌یهراهبرا‌یهتعریفهدرهمعرضهآفتابهاقرارهدادنهبازهمیهکند.در
معرضهآفتابهاقرارهدادنهبههیکهاثرهکههشبیههچیز‌یهاستهکههمیهتواندهاتفااقهبیفتدهزمانی

کههدرهطولهگسترشهاعکسهخیلیهروشنهترهاست.
پاررامتره‌هاههدرجههوهنوعهدرهمعرضهآفتابهاقرارهگرفتنهراهمشخصهمیهکند.
حدهآستانهههدرجهه‌یهروشناییهراهمشخصهمیهکند.هدرهدرصدهبالهکههدرهآن

هپیکسله‌هاه
معکوسهکردنههمعکوسه‌همهه‌یهپیکسله‌هاهراهمشخصهمیهکند.

کهنههکردنه

‌همهه‌یهپیکسله‌هاهبههمقداره‌ها‌یهخاکستریشانهتنظیمهمیهشوندهوهسپس
کاناله‌ها‌یهرنگهسبزهوهآبیباهمقدارهمشخصهشدههتوسطهشماهکا‌هشهمیهیابد.کانالهرنگ

اقرمزهتغییر‌یهنمیهکند.
%هشماهمقدار0درجهه‌یهکهنگی-شدتهکهنگیهراهباهدرهصدهمشخصهمیهکند.در

%هفقطهکانالهرنگهاقرمزهبااقیهمیهماند.100خاکستر‌یهازهپیکسله‌هاهرامیهبینید.در

یکهکادرهمحاورهها‌یهراهبرا‌یهتعیینهتعدادهرنگه‌ها‌یهپوسترهبازهمیهکند.اینهاثرهبرا‌یپوسترهکردنه
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اثرنام آیکون

کا‌هشهتعدادهرنگه‌هاهبههاعنوانهیکهپایههاست.کههیکهتصویرهشبیههنقاشیهمیهسازد.
رنگه‌ها‌یهپوستر:تعدادهرنگه‌هاییهراهکههپوسترهکا‌هشهمیهد‌هدهراهمشخصهمیهکند.

یکهتصویرهراهبههفرمته‌هنرهپاپهتبدیلهمیهکند.‌هنرهپاپ

طرحهذغال
تصویرهرادرهطرحهزغالهنمایشهمیهد‌هد.خطوطهتصویرهبههصورتهسیاههکشیده

میهشوند.وهرنگه‌ها‌یهاصلیهراهخنثیهمیهکند.

برجستههکردن

یکهکادرهمحاورهها‌یهرابرا‌یهایجادهبرجستگیهنمایشهمیهد‌هد.شماهمیهتوانیدهیک
مکانهبرا‌یهیکهمنبعهنورهخیالیهکههتعیینهکنندهه‌یهنوعهسایهه‌یهایجادهشدههوهچگونگی

برجستههشدنهتصویرهگرافیکیهاستهراهانتخابهنمایید.
منبعهنورهمکانهوهمواقعیتهمنبعهنورهراهمشخصهمیهکند.نقطههنشانهد‌هندهه‌ی

منبعهنورهاست.

موزاییک

گرو‌هها‌یهکوچکهازهپیکسله‌هاهراهبههمناطقهمستطیلهشکلهباهرنگهیکسانهپیوند
میهد‌هد.مستطیله‌ها‌یهمنحصرهبفردهبزرگهتر،هجزئیاتهکمتر‌یهازهشکلهگرافیکیهراهدراند.

اعرضهاعرضه‌هرهکاشیهمنحصرهبفردهراهتعیینهمیهکند.
ارتفاعهارتفاعه‌هرهکاشیهمنحصرهبفردهراهتعیینهمیهکند.

تغییر حالت گرافیکی
Default.هنمایشیهازهاشیاءهگرافیکیهکههتغییرهنمیهههکنند-

Grayscaleگ -هشئهگرافیکیهدرهمقیاسهخاکستر‌یهنمایشهدادههمیهههشوند.هشئهگرافیکیهرنگیهمیهههتوانندهبصورتهتکهرن
درمقیاسهخاکستر‌یهظا‌هرهشوند.هشماه‌همچنینهمیهههتوانیدهازهلغزندهه‌هاه‌یهرنگیهبرا‌یهنمایشهرنگهیکنواختهدرهشههئهگرافیکههی

تکهرنگهاستفادههنمایید.
Black/Whiteره ناییه‌ها‌یهزی %هبههه50-هشئهگرافیکیهدرهاقالبهسیاهههوهسفیدهنمایشهدادههمیهههشوند.ه‌همههه‌یههمقادیرهروش
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%هبههصورتهسفیدهنمایشهدادههمیهههشوند.50صورتهسیاههظا‌هرهمیهههشوند،ه‌همههه‌یههمقادیرهروشناییهبال‌یه
Watermarkتهدر کهاعلم وانهی -باهاینهگزینههروشناییهشئهگرافیکیهکا‌هشهمیهیابدهبههطور‌یهکههمیهتوانهآنهراهبههاعن

پسهزمینههاستفادههکرد.

تنظیم رنگ
Formatبرا‌یهتنظیمهرنگ،هپاکهکردن،هویرایشهیاهاضافههکردنهرنگه‌هاهبصورتهداقیقهتر،هدرهنوارهمنو‌یهاصلیهبههمسههیره  >

Areaهمیهرویمهتاهکادرهمحاورههاه‌یهAreaربرگ رهرو‌یهس پسهب ود،هس اورههاه‌یههColorsهبازهش ادرهمح نهک م.های کهمیهکنی هکلی
هنشانهدادههایم.4.13شکلهگزینهه‌هاه‌یهزیرهراهدرهزمانهکارهباهرنگه‌هاهفرا‌همهمیهههکند.ه‌همانطورهکههدر

Nameهنامهرنگهانتخابهشدههراهتغییرهمیهههد‌هد.ه‌همچنینهمیهههتوانیمهنامیههههراهدرهزمانهتعریفهیکهرنگهجدیدهدرهاینهکادر-
تایپهکنیم.

Color.ه–هشاملهلیستیهازهرنگه‌ها‌یهموجودهاسته.هبرا‌یهانتخابهیکهرنگ،هیکیهراهازهلیستهانتخابهمیهکنیم
Color  table)هبرا‌یهتغییرهرنگه‌ها؛همدلهرنگهراهانتخابهمیهنماییم:هاقرمز-هسبز-هآبیه-RGB-هیاهفیههروزههاه‌یهه-ارغهوانی(
هCMYKهبرا‌یهپرینتهرنگیهاستفادههمیهههکند.هکنترله‌ها‌یهRGBهفقطهازهمدلهرنگهLibreOffice).هههCMYKزرد-همشکیه( هب

همشخصهمیهههکند.CMYKراحتیهمقدارهرنگهاستفادههشدههدرهورود‌یهراهباهاستفادههازهنماده
گهراهازهRGBاگره ش،هرن اهدکمههه‌یههچرخ وانیمهب اهمیهههت 255هتههاه0هراهانتخابهکنیم،هدرهابتداهسههرنگهظا‌هرهمیهههشودهوهم
تنظیمهکنیم.
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تنظیم شفافیت شئ
م.Picture،هدرهنوارابزارهههTransparencyبرا‌یهتغییرهمقدارهدرصدهوهایجادهتصویرهشفافهترهبرهرو‌یهآیکونه کهمیهکنی هکلی

‌همانطورهکههمقدارهکاما،هباهافزایشهشفافیتهتصویرهبااعثهیکنواختهشدنهتصویرهدرهپسهزمینههمیهههشود.
Formatبرا‌یهتنظیمهکردنهتنظیماتهشفافیتهکههبرا‌یهیکهتصویرهااعمالهمیهههشود،هدرهنوارهمنههو‌یهاصههلیهبهههه  >  Area

ههدرTransparencyهبازهشودهسپسهبرهرو‌یهسربرگهAreaهمیهرویمهتاهکادرهمحاورههاه‌یه انطورهک 4.14شکلههکلیکهمیهکنیم.‌هم
نشانهدادههایم.ه

Area : کادر محاوره ا ی 4.13شکل 
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No transparency.هشفافیتهرنگهراهاقطعهمیهههکند.هاینهتنظیماتهبصورتهپیشهفرضهاست-
Transparencyههدرهآن ادر‌یهک %0-هشفافیتهرنگهراهفعالهمیهههکند.هاینهگزینههراهانتخابهکردههوهسپسهدرصدهراهدرهک

للهماتهوه للهشفافهاستهراهواردهکنید.100کام %هکام
Gradientپس دهوهس ابهکنی ههراهانتخ نهگزین د.های الهمیهههکن یهااعم دههه‌یهفعل -هیکهدرجههه‌یهشفافیتهراهبههرنگهپرهش

گزینهه‌هاه‌یهشفافیتهراهتنظیمهنمایید.

Transparency: سربرگ 4.14شکل 
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سایه دار کردن یک تصویر- 4.5.4 
برا‌یهسایههدارهکردنهتصویرهدرهاسلیدهبههروشهزیرهاعملهمیهکنیم:

زارهShadowابتداهتصویرهموردهنظرهراهانتخابهکردههوهسپسهبرهرو‌یهآیکههونه• وارهاب م،Imageهازهن کهمیهکنی هکلی
هنشانهدادههایم.4.15شکله‌همانطورهکههدر

همیهرویمهتاهکادرFormat > Areaبرا‌یهتنظیمهکردنهتنظیماتهااعمالهشدههبرهرو‌یهیکهتصویر،هدرهنوارهمنو‌یهاصلیهبهه•
هکلیکهمیهکنیم.Shadowهبازهشود.هسپسهبرهرو‌یهسربرگهAreaمحاورههاه‌یه

درهجاییهکههمیهههخوا‌هیمهسایههراهاقرارهد‌هیم،هکلیکهمیهکنیم.•
فاصلهها‌یهراهکههمیهههخوا‌هیمهسایههازهشئهانتخابهشدههداشتههباشدهراهواردهمیهکنیم.•
یکهرنگهبرا‌یهسایههانتخابهمیهنماییم.•
%(شفافیت)هبرا‌یهتغییرهشفافیتهسایه،هواردهمیهکنیم.100%(ماتهبودن)هتاه0یکهدرصدهراهازه•
ازهجعبههه‌یهههپیشهفرضهبرا‌یهنمایشهتغییراتهاقبلهازهاینکههاثراتهشفافیتهراهدرهرنگهپرهشدههازهشئهانتخابهشدههااعمال•

کنیم،هاستفادههمیهنماییم.

ویرایش و قالب بند‌ی ترسیمات - 4.6 
زارهDrawingبرا‌یهرسمهوهویرایشهاشکالهترسیمیهدرهاینهنرمهافزارهازهنوارهابزاره وارهاب م.هن هازDrawingهاستفادههمیهکنی

رارView>Toolbars>Drawingمسیره اهاق ارهم شهآنهدرهاختی هفعالهمیهشودهوهگزینهه‌ها‌یهزیاد‌یهراهبرا‌یهترسیمهشکلهوهویرای
میهد‌هد.

: دکمه ایجاد سایه4.15شکل 

Drawing: نوار ابزار 4.16شکل 
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هنشانهدادههایمهوهباهاسههتفادههاز4.17شکلهدرهابتدا‌یهاینهنوارهگزینهه‌ها‌یهزیاد‌یهبرا‌یهترسیمهوجودهدارد‌همانطورهکههدر
اینهگزینهه‌هاهمیهتوانیمهترسیماتهدلخواههراهانجامهد‌هیم.

تغییر اندازه - 4.6.1 
اگرهبخوا‌هیمهکههاندازهه‌یهیکهشکلهراهتغییرهد‌هیمهبههروشهزیرهاعملهمیهکنیم:

هشکلهموردهنظرهراهانتخابهمیهکنیم.•
هباهنشانگرهماوسهبرهرو‌یهدستگیرهه‌ها‌یهظا‌هرهشدههدرهاطرافهشکلهکلیکهکردههوهبههاندازهه‌یهدلخواههمیهکشیمهتاهشکل•

ماهبههاندازهه‌یهدلخواههدرآید.ه
هراهانتخابهمیهکنیم.Position and Sizeبرا‌یهتنظیمهداقیقهترهرو‌یهشکلهراستهکلیکهوهگزینهه‌ی•
هبازهمیهشود.Position and Sizeهکادرهمحاورهها‌یه•

هنشانهدادههایم.4.18شکلههاندازههداقیقهراهواردهمیهکنیم.‌همانطورهکههدرSizeهوهدرهبخشهPosition and Sizeهدرهزبانهه

: ابزارهای ترسیم4.17شکل 
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چرخش و تغییر زاویه - 4.6.2 
هاستفادههمیهکنیم.هDrawingبرا‌یهچرخشهتصویرهوهتغییرهزاویهه‌یهآنهازهآیکونه‌ها‌یهموجودهدرهنوارهابزار

یاهبرهرو‌یهشکلهدوبارکلیکهمیهکنیمهوهسپسهازهدستگیرهه‌ها‌یهاقرمزهراهبرا‌یهچرخههشهاسههتفادههمیهکنیههم.‌همههانطورهکههه
هنشانهدادههایم.4.19شکلهدر

Position and Size: کادر محاوره ای 4.18شکل 
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برا‌یهچرخشهداقیقهبههروشهزیرهاعملهمیهکنیم:
هبرهرو‌یهشکلهراستهکلیکهمیهکنیم.•
هبازهشود.Position and Sizeهراهانتخابهمیهکنیمهتاهکادرهمحاورهها‌یهPosition and Sizeگزینهه‌ی•

RotationهوهدرهبخشهRotationدرهزبانهه  Angleهنشههانهداده4.20شکلههزاویههداقیقهراهواردهمیهکنیم.‌همانطورهکههدر
ایم.

: چرخش یک شکل4.19شکل 
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Pivotدرهاقسمته  pointئ زهش ،همواقعیتهنقطهه‌یهمحور‌یهراهانتخابهکنید.همواقعیتهپیشهفرضهنقطهه‌یهمحور‌یهدرهمرک
است.

تغییر خصوصیات - 4.6.3 
باهانتخابهشکلهموردهنظرهوهراستهکلیکهکردنهبرهرو‌یهآنهوهانتخابهگزینهه‌ها‌یهموجودهازهمنو‌یهزمینهها‌یهکههبازهاسههت،

خصوصیاتهشکلهراهتغییرهمیهد‌هیم.ه

جلوه دار کردن - 4.6.4 
رهرو‌یهآنهراسهتهکلیهک رهراهانتخهابهکهردههوهب برا‌یهجلوههدارهکردنهتصاویرهنیزهبهه‌همانهشیوهه‌یهاقبلهتصویرهموردهنظ

Position and Size در کادر محاوره ای Rotation: زبانه 4.20شکل 
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میهکنیمهوهازهگزینهه‌ها‌یهموجودهدرهمنو‌یهزمینههمیهتوانیمهبههتصویرمانهجلوهه‌هاه‌یهمتنواعیهازهاقبیلهافقیهوهاعموده‌یهکردن،هسههه
بعد‌یهکردنهوه…هببخشیم.ه

 اشیاءترازبند‌ی- 4.6.5 
ازهابزار‌ها‌یهترازبند‌یهفقطهبرا‌یهمواقعیتهشئهبههشئهدیگرهاستفادههمیهکنیم.هاینهابزاره‌ههها‌یهترازبنههد‌یهفقههطهدرهصههورتی

موجوده‌هستندهکههدوهشئهیاهبیشترهانتخابهشدههباشد.
اشیائیهکههمیهخوا‌هیمهترازبند‌یهشوندهراهانتخابهمیهنماییم.

هاقرارهداردهکلیکهمیهکنیم.AlignmentهوهدرهسمتهراستهآیکونهLine and Fillingبرهرو‌یهمثلثیهکههدرهنوارابزاره
هیاهبههروشهدیگر:

هبازهشود.‌همانطورهکهAlign ObjectsهمیهرویمهتاهابزارView > Toolbars > Align Objectsهدرهنوارهمنو‌یهاصلیهبهه
هنشانهدادههایم.4.21شکلهدر

للهانتخابهشدههبودهبستگیLine and FillingهکههدرهنوارابزارهAlignmentهآیکونه هاقرارهداردهبههگزینهه‌یهترازبند‌یهکههاقب
دارد.

،هوهیکیهازهگزینهه‌ها‌یهترازبند‌یهراAlignmentبههروشهدیگر،هبرهرو‌یهگرو‌هیهازهاشیاءهانتخابهشدههراستهکلیکهکردههوه
ازهمنو‌یهزمینههانتخابهنمایید.

گزینهه‌ها‌یهترازبند‌یهبههصورتهزیرهاست:
چپ،همرکز،هراست:هترازهافقیهاشیاءهانتخابهشدههراهتعیینهمیهکند.•
بال،همرکز،هپایین:هترازهاعمود‌یهاشیاءهانتخابهشدههراهتعیینهمیهکند.•

Align Objects: ابزار4.21شکل 
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مرتب کردن اشیاء- 4.6.6 
دimpressنرمهافزاره رارهدارن تههاق ال‌یهدس طحهب هاشیاءهراهدرهیکهدستههسازمانهد‌هیهمیهکند.هبنابراینهاشیاییهکههدرهس

اشیاءهدرهسطحه‌ها‌یهپایینهدستههراهمیهپوشانندهاگره‌هرهکدامهباه‌همهتداخلهدارند.هسطحهدستههازه‌هرهشههئهمیهتوانههدهبههههوسههیلهه‌ی
اشکالهدرهاسلیدهیاهصفحههمرتبهشوند.

برا‌یهتغییرهسطحهدستههازهشئ،هیکهشئهیاهاشیائهراهانتخابهکردههوهسپسهبرهرو‌یهمثلثهکههوچکیهکههههدرهکنههارهآیکههون
ArrangeهدرهنوارابزارهLine  and  Fillingوارابزاره ونهPositionهاقرارهداردکلیکهمیهکنیمهتاهن ود.هآیک ازهش ههدرArrangeهب هک
Lineنوارابزاره  and  Fillingه للهانتخابهشدههاندهبستگیهدارد.‌همانطورهک هنشانهدادههمیهشودهبههگزینهه‌ها‌یهمرتبهساز‌یهکههاقب
هنشانهدادههایم.4.22شکلهدر

رهرو‌یArrangeبههروشهدیگر،هبرهرو‌یهاشیائهانتخابیهراستهکلیکهمیهکنیمهوهگزینهه‌یه پسهب هراهانتخابهمیهنماییم.هس
گزینهه‌یهمرتبهساز‌یهراهازهمنو‌یهزمینههانتخابهمیهکنیم.

ازهچهارهابزار،هاولینهابزارهتعیینهسطحهدستهه‌یهشئهانتخابهشدههاست.
Bring to front.هشئهانتخابهشدههدرهمقابله‌همهه‌یهاشیائهدیگرهحرکتهمیهکند-
Bring forward.هشئهانتخابهشدههبههیکهسطحهبالترهدردستههحرکتهمیهکند:

Send backwards.هشئهانتخابهشدههبههیکهسطحهپایینهترهدرهدستههحرکتهمیهکند:
Send  to  backبی واقعیتهنس :هشئهانتخابهشدههدرهپشته‌همهه‌یهاشیائهدیگرهحرکتهمیهکند.هبقیهه‌یهسههابزارهدیگر،هم

اشیاءهانتخابهشدههراهتعیینهمیهکند:
In front of object.هاولینهشئهانتخابهشدههراهدرهمقابلهدومینهشئهانتخابهشدههحرکتهمیهد‌هد:

Behind object.هاولینهشئهانتخابهشدههراهدرهمقابلهدومینهشئهانتخابهشدههحرکتهمیهد‌هد:
Reverse.هنظمهوهترتیبهاقرارهگرفتنهدوهشئهانتخابهشدههراهاعوضهمیهکند:

Position: نوارابزار 4.22شکل 
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Fontwork استفاده از - 4.6.7 
FontworkهدرهنوارابزارهFontwork Galleryهبرا‌یهاثره‌ها‌یهچرخشهمتنهاستفادههمیهکنیم.هبرهرو‌یهآیکونهFontworkازه

Fontworkهکلیکهمیهکنیمهتاهکادرهمحاورهها‌یهFontworkیاهنوارابزاره  Galleryههدره انطورهک نشههان4.23شکلههبازهشود،ه‌هم
دادههایم.

هنشانهدادههایم.4.24شکله،هاینهنوارابزارهشاملهابزار‌ها‌یهزیرهاست:ه‌همانطورهکههدرFontwork Galleryاعلوههبرهآیکونه

Fontwork: نوارابزار 4.24شکل 

Fontwork Gallery: کادر محاوره ای 4.23شکل 



95جزوهه‌یهآ‌موزشیه‌مهارتهکارهباهنرمهافزارهارائهه‌مطلب

Fontwork  Shapeرهرو‌ی ردنهب :هشکلهشئهانتخابهشدههراهتغییرهمیهد‌هد.هشکله‌هاهازهگزینهه‌هاییهکههدرهزمانهکلیکهک
شئهموجودهاستهانتخابهمیهشوند.

Fontwork Same Letter Heightsهارتفاعهکاراکتر‌هاهراهدرهشئهانتخابیهتغییرهمیهد‌هد.هبینهحالتهارتفاعهنرمالهکههدر:
آنهکاراکتره‌هاهارتفاعه‌ها‌یهمتفاوتیهبههجاییهکههدرهآنه‌همهه‌یهکاراکتره‌هاهارتفاعهیکسانیهدارندهتغییرهوضعیتهمیهد‌هند.

Fontwork Alignment.هترازبند‌یهمتنهراهباهیکهاقالبهازهگزینهه‌ها‌یهموجودهتغییرهمیهد‌هد:
Fontwork Character Spacingهیکهفاصلهه‌یهدلخواههراهبینهکاراکتره‌هاهانتخابهکردههومشخصهمیهکندهکههآیاهزوجه‌ها‌ی:

ه%فاصههلههگذار‌ی100بهمهچسبیدههبایدهاستفادههشوند.بههرا‌یهفاصههلههگههذار‌یهسفارشههی،هیههکهمقههدارهدرصههدهراهواردهمیهکنیههم.
%هفاصلهه‌یهگسترشهیافتههاست.100%فاصلهه‌یهکمه(تنگ)هاست.هبیشترهازه100استاندارد‌یهاست.هکمترهازه

قالب بند‌ی جداول - 4.7 
انتخاب سطر، ستون و سلول - 4.7.1 

برا‌یهانتخابهسلوله‌ها‌یهجدولهباهکشیدنهوهر‌هاهکردنهبرهرو‌یهسلوله‌ها‌یهجدولهآنه‌هاهراهانتخابهمیهکنیم.

درج سطر و ستون جدید در جدول - 4.7.2 
برا‌یهدرجهسطرهیاهستونهجدیدهدرهجدولهبههروشهزیرهاعملهمیهکنیم:

هبرهرو‌یهجدولهکلیکهمیهکنیمهتاهدستگیرهه‌ها‌یهانتخابیهدرهاطرافهجدولهنمایشهدادههشوندهوهدرهحههالتهانتخههاب•
اقرارهبگیرند.

اهRow>Insertهسپسهبرهرو‌یهجدولهراستهکلیکهکردههوهازهگزینهه‌یه• تونColumn>Insertهی اهس طرهی کهس هی
جدیدهراهبههجدولهمانهاضافههمیهکنیم.

‌همهچنینهبرا‌یهایجاده‌هرهگونههتغییرهدرهجدولهبایدهآنهراهدرهحالتهانتخابهاقرارهدادههوهبههرهرو‌یهآنهراسههتهکلیههک•
نمودههوهازهمنو‌یهزمینهها‌یهکههبازهمیهشودهگزینهه‌ها‌یهموردهنظرهراهانتخابهنماییم.

حذف سطر و ستون از جدول - 4.7.3 
برا‌یهحذفهکردنهیکهسطرهیاهستونهازهجدولهبههروشهزیرهاعملهمیهکنیم:

هسطرهیاهستونهموردهنظرهراهانتخابهمیهکنیم.•
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<ColumnهیاهRow>Deleteهبرهروه‌یهسطرهیاهستونهانتخابیهراستهکلیکهمیهکنیمهوهازهمسیره‌ها‌یه•  Deteteا ،هسطرهی
ستونهموردهنظرهراهحذفهمیهکنیم.

هدرهصفحههکلیدهاستفادههنماییم.هDeleteهبرا‌یهاینهکارهمیهتوانیمهازهکلیده•

ادغام چند خانه ‌ی فرعی در یک خانه ‌ی اصلی- 4.7.4 
برا‌یهاقرارهدادنهچندهخانهه‌یهفراعیهدرهیکهخانهه‌یهاصلیهبههروشهزیرهاعملهمیهکنیم:

،هبرهرو‌یهخانهه‌یهموردهنظرهراستهکلیکهمیهکنیم.•
هبازهشود.Splite Cellهراهانتخابهمیهکنیمهتاهکادرهمحاورهها‌یCell> Splitهازهمنو‌یهزمینه،همسیر•
هازهاینهکادرهمحاورهها‌یهمیهتوانه‌هرهتعدادهخانهه‌یهموردهنیازهراهدرهیکهسلولهادغامهکرد.•
‌همهچنینهباهاستفادههازهاینهکادرمحاورهها‌یهمیهتوانیمهافقیهیاهاعمههود‌یهبههودنهخههانهه‌ههها‌یهادغههامهشههدههراهانتخههاب•

نماییم.

تنظیم اندازه ‌ی سطر و ستون ها - 4.7.5 
برا‌یهتنظیمهاندازهه‌یهسطرهیاهستونه‌هاهبههروشهزیرهاعملهمیهنماییم:

هبرهرو‌یهسطرهیاهستونهموردهنظرهراستهکلیکهمیهکنیم.•
هبازهشود.Position & Sizeهراهانتخابهمیهنماییمهتاهکادرمحاورهها‌یهPosition & Sizeازهمنو‌یهزمینههگزینهه‌یه•
ازهاینهکادرهمیهتوانهاندازهه‌یهسطره‌هاهوهستونه‌هاهوه‌همچنینهمواقعیتهجدولهراهتعیینهنمود.•

متحرک ساز ‌ی ارائه -  5 
متحرک ساز‌ی اسلید- 5.1 
مفاهیم متحرک ساز‌ی- 5.1.1 

اسلید‌ها‌یهمتحرکهشبیههبههگذاره‌هاه‌هستند،هاماهآنه‌هاهبرا‌یهاعناصرهمنحصربههفردهدرهیکهاسلیدهمنفرد:هموضههوع،هنمههودار،
شکل،هیاهنقاطهاعلمتهگذار‌یهمنحصربههفردهااعمالهمیهشوند.هتصاویرهمتحرک،همیهتوانندهیکهارائههراهزندههوهبههیادهمانههدنیهکننههد.
‌همانهطورهکههدرهگذار،هاستفادهه‌یهزیادهازهانیمیشنه‌ها،همیهتواندهسرگرمهکنندههباشد،هاماهبرا‌یهمخاطبههانیهکهههانتظههارهیههکهارائهه‌ی
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حرفهها‌یهدارند،همنحرفهکنندههوهحتیهآزارهد‌هندههاست.

اضافه کردن گذر- 5.1.2 
،هاسلیدهدلخواههراهنمایشهدادههوهسپسهمتنهیاهشئهکههمیهخوا‌هیمهمتحرکهشودهراهانتخابهمیهکنیم.Normalدرهنمایشه

یکهشئهازهاقبیلهیکهگرافیکهیاهیکهجعبههمتنهدستهنخوردههدرهزمانیهکههانتخههابهشههوندهدسههتگیرهه‌ها‌یهانتخههابیهدرهاطههراف
شکلهنمایشهدادههمیهشوند.

نکته:هاگرهماهفقطهیکهبخشهازهمتنهراهدرهیکهجعبههمتنهانتخابهکنیم،هدیگرهدستگیرهه‌ها‌یهانتخابیهراهنخوا‌هیمهدید.
هکلیکهمیهکنیم.هWorkspaceهدرهفضا‌یهکار‌یهNormalرفتههیاهبرهرو‌یهسربرگهView>Normalهدرهنوارهمنو‌یهاصلیهبهه

اسلیدهوهشئهکههمیهخوا‌هیمهاثرهانیمیشنیهراهدرهآنهااعمالهکنیمهراهمشخصهمیهکنیم.ه
هبازهشود،ه‌همانطورهکههدرCustom AnimationهراهانتخابهمیهکنیمهتاهکادرهCustom Animation،هآیکونهSidebarدره
هنشانهدادههایم.5.1شکله
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گزینهه‌ها‌یهاینهکادر:
•Add Effect.هیکهاثرهانیمیشنهراهبههیکهشئهدرهیکهاسلیدهاضافههمیهکند:
•Remove Effect.هاگرهبرهرو‌یهاینهآیکونهکلیکهکنیم،ه‌هرهاثرهانیمیشنهانتخابهشدههازهشئهبازهمیهگردد:
•Modify Effect.هاثرهانیمیشنیهااعمالهشدههبرهرو‌یهیکهشئهدرهاسلیدهراهتغییرهمیهد‌هد:
•Move  Upن :هبرا‌یهحرکتهاثرهانیمیشنیهااعمالهشدههدرهجهتهبال‌یهاثرهانیمیشنیهباهیکهشئهااعمالهشده،هبرهرو‌یهای

آیکونهکلیکهمیهکنیم.
•Move  Downرهرو‌ی ده،هب :هبرا‌یهحرکتهاثرهانیمیشنیهااعمالهشدههدرهجهتهپایینهاثرهانیمیشنیهباهیکهشئهااعمالهش

اینهآیکونهکلیکهمیهکنیم.

Custom Animation: کادر 5.1شکل 
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•Preview Effect.هبرا‌یهنمایشهاثرهانیمیشنیهااعمالهشدههبرهرو‌یهیکهشئ،هبرهرو‌یهاینهآیکونهکلیکهمیهکنیم:
•Start.هچگونگیهشروعهشدنهیکهاثرهانیمیشنیهدرهزمانهاجرا‌یهانیمیشنهراهازهلیستهکشوییهانتخابهمیهکند:
باهکلیکهکردن:هتاهزمانهکلیکهبعد‌یهماوس،هانیمیشنهدرهاینهاثرهمتواقفهمیهشود.•
‌همراههباهاقبلی:هانیمیشنهفورلاهاجراهمیهشود.•
پسهازهاقبلی:هبههمحضهاتمامهانیمیشنهاقبلی،هانیمیشنهاجراهمیهشود.•
•Direction.هازهلیستهکشوییهچگونگیهظا‌هرهشدنهاثرهانیمیشنیهدرهاسلیدهراهانتخابهمیهکنیم:
•Speed.هسراعتهیاهمدتهاثرهانیمیشنهانتخابهشدههراهانتخابهمیهنمایید:
•Automatic  previewاورهها‌یه ادرهمح ههازهک نیهک رهانیمیش کهاث ارهی ایشهخودک را‌یهنم Custom:هاینهگزینههراهب

Animation.هانتخابهشدههاست،هبرهمیهگزینیم
•Effect  Optionsهبرهرو‌یهاینهآیکونهکلیکهمیهکنیمهتاهکادرمحاورهها‌یه:Effect  Optionsادر نهک ههدرهای ودهک هبازهش

میهتوانیمهگزینهه‌هاهراهدرهاثرهانیمیشنیهوهزمانهانتخاب،هتنظیمهوهااعمالهنماییم.
هنشانهدادههایم.5.2شکلههبازهمیهشود،ه‌همانطورهکههدرهEntranceهکنیم،هکادرهمحاورهها‌یهکلیکهAddاگرهبرهرو‌یه•
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انواعهاثر‌ها‌یهانیمیشنیهراهازهیکیهازهصفحاتهجدولهبند‌یهشدههدرهاینهکادرهانتخههابهمیهکنیههم.هبیشههترهازهیههکهنههوعهاثههر
رارEntranceانیمیشنیهدرهیکهشئهااعمالهمیهشود.هازهصفحهه‌یه هبرا‌یهااعمالهاثرهانیمیشنیهدرهزمانیهکههشئهبرهرو‌یهصفحههاق

هبرا‌یهااعمالهیکهاثرهانیمیشنیهبههیکهشئهاستفادههمیهشود.Emphasisمیهگیردهاستفادههمیهکنیم.هازهصفحهه‌یه
هبرا‌یهمثال،هتغییرهدادنهرنگهاقلمهیاهاضافههکردنهاثره‌ها‌یهخاصهازهاقبیلهچشمکهزدنهمتن.

هبرا‌یهااعمالهاثرهانیمیشنیهدرهزمانیهکههیکهشئهصفحههنمایشهراهترکهمیهکندهاستفادههمیهشود.هاگرهماExitهازهصفحهه‌یه
Motionبخوا‌هیمهکههشئهدرهطولهیکهخطهیاهمنحنیهحرکتهکند،هیکهاثرهانیمیشنهراهازهصفحهه‌یه  Paths.م ابهمیهکنی هانتخ

رSpeedمدتهزمانهاثرهانیمیشنهراهازهلیستهکشوییه وانیمهاث اهآنهمیهت ههب زینهه‌یهراهک از،هگ ورتهنی م.هدرهص هانتخابهمیهکنی

Entrance: کادر محاوره ای 5.2شکل 
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انیمیشنهراهدرهشئهبررسیهکنیم،هانتخابهمیهکنیم.ه

تغییر تنظیمات گذر اسلید- 5.1.3 
برا‌یهتغییرهتنظیماتهگذرهاسلید،هبرهرو‌یهاسلیدهموردهنظرهکلیکهکردههوهآنهراهانتخابهمیهنماییمهسپسهبرهرو‌یهآیکههون

Slide  Transitionوییه و‌یهکش Slideهکههدرهسمتهراستهفضا‌یهکار‌یهاقرارهداردهکلیکهکردههوهازهمن  transitionذر وعهگ هن
دلخواههراهانتخابهمیهنماییم.ه

متحرک ساز‌ی اشیاء- 5.2 
اعمال جلوه ها‌ی ورود، تمرکز و خروج - 5.2.1 

برا‌یهمتحرکهساز‌یهاشیاء،هابتداهیکهشههئهراهدرهاسههلیدهواردهمیهکنیههم.هشههئهواردهشههدههراهانتخههابهکههردههوهازهاقسههمت
Sidebarهگزینهه‌یهCustom  Animationاز اورهها‌یهب ادرهمح هراهانتخابهمیهکنیم.هبرهرو‌یهگزینهه‌ی+هکلیکهمیهکنیمهتاهیکهک

وهخروجEmphasis،هتمرکزهEntranceشود.هدرهاینهکادرهمحاورهها‌یهسربرگه‌هاییهوجودهداردهکههنشانهد‌هندهه‌یهجلوهه‌ها‌یهورود
Exitزینهه‌یه رهرو‌یهگ مهوهب ابهمیهکنی ودهراهانتخ ا‌یهموج Okهاست.هبرهرو‌یه‌هرهکدامهازهاینهسربرگه‌هاهکلیکهکردههوگزینهه‌ه

کلیکهمیهکنیمهتاهاینهجلوهه‌هاهااعمالهشود.ه

تغییر و حذف جلوه ها- 5.2.2 
Customبرا‌یهتغییرهوهحذفهجلوهه‌هاهنیزهبرهرو‌یهشئهکلیکهمیهکنیمهوهازهگزینهه‌هاییهکههدرهپههایینهکههادره  Animation

اقرارهدارد،همیهتوانیمهجلوهه‌هاهراهحذفهکردههوهیاهتغییرهد‌هیم.ه

ترکیب چند جلوه - 5.2.3 
متهokاگرهبخوا‌هیمهچندهجلوههراهترکیبهکنیمه‌هرهشئهراهانتخابهکههردههوهبههرهرو‌یه مهوهدرهاقس کهمیکنی Customهکلی

Animationرا‌ی ت.هب اهاس هجلوهه‌هاییهکههاضافههکردههایمهنمایشهدادههمیهشودهاینهاعمل،هترکیبهچندهجلوههبرا‌یهنمایشهشئه‌ه
هکادرoptionمثالهمیهتوانیمهبرا‌یهورودهشئهیکهجلوههوهبرا‌یهخروجهآنهنیزهیکهجلوههداشتههباشیم.هباهکلیکهبرهرو‌یهگزینهه‌ی

محاورهها‌یهبازهمیهشودهکههباهآنهمیهتوانهزمانهراهبرا‌یهنمایشهجلوهه‌هاهتنظیمهنمود.
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زمان بند‌ی- 5.3 
تعیین زمان و نوع اجرا‌ی جلوه ها - 5.3.1 

هراهاجراهکنیمهوRehearse TimingsهفرمانهSlide Showبرا‌یهزمانهبند‌یهمناسبهتعویضهاسلید‌هاهمیهتوانیمهازهمنو‌یه
‌همزمانهباهنمایشهاسلید‌هاهدرهزمانهمناسبهاسلید‌هاهراه‌هدایتهکنیمهاینهزمانهبرهرو‌یهاسلیدهذخیرههخوا‌هدهشد،ه‌همانطورهکه

هنشانهدادههایم.5.3شکلهدره

آماده ساز‌ی برا‌ی ارائه -  6 
آماده ساز‌ی اسلیدها- 6.1 

شماهمیهتوانیدهچندینهوجههازهجزوههراهازهسبکهصفحههدرهاعناصر‌یهکههدرهصفحههنمهایشهدادههمیهشهوند،هفرمههتهکنیههد.
شماهنمیهتوانیدهصفحهه‌ها‌یهجزوهه‌یهمنحصرهبههفردهوه‌هرهتغییراتهنمایشهدادههشدههدره‌همهه‌یهجههزواتهدرهفایههلهارائههههراهفرمههت

کنید.

Rehearse Timings: فرمان 5.3شکل 
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انتخاب شکل خروجی مناسب برا‌ی نمایش اسلیدها - 6.1.1 
ههWorkspaceهکههدرهبال‌یهفضا‌یهکار‌یهHandoutبرهرو‌یهسربرگه Viewهاقرارهداردهکلیکهکردهههیاهازهنوارهمنو‌یهاصلیهب

> Handout Pageهبرویدهتاهصفحهه‌یهHandoutهنشانهدادههایم.6.1شکلههبازهشود،ه‌همانطورهکههدره

< Slide،هراهانتخابهنموده،هیاهبرهرو‌یهجزوههراستهکلیکهکردههوهمسیرهFormat > Pageسپسهازهمنو‌یهاصلیهمسیره

Page Setupهراهازهمنو‌یهpop-upهانتخابهمیهکنیمهتاهکادرهمحاورهها‌یهPage Setup.هبازهشود
اندازهه‌یهصفحه،هجهته(افقیهیاهاعمود‌ی)،هحاشیهه‌هاهوهدیگرهگزینهه‌ها‌یهپرینتهراهتنظیمهمیهکنیم.

هبستههشدههوهاعملیاتهچاپهشروعهشود،ه‌همانطورPrint dialogهکلیکهمیهکنیمهتاهکادرهمحاورهها‌یهOkدرهنهایتهبرهرو‌یه
هنشانهدادههایم.6.2شکلهکههدره

: نمایش سبک صفحه6.1شکل 
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 میلی متر‌ی و نمایش رو‌ی صفحه 35ارسال به رسانه ها، اسلیدها‌ی - 6.1.2 
برا‌یهآمادههساز‌یهاسلید‌هاهوهارسالهبههرسانهه‌ها‌یهمختلفهمراحلهزیرهراهانجامهمیهد‌هیم:

هنشانهدادههایم.6.3شکلهنحوههنمایشهاسلیدهراهدرهحالتهنرمالهاقرارهمیهد‌هیم،ه‌همانطورهکههدره-1

: کادر تنظیمات صفحه6.2شکل 
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هنشانهدادههایم.6.4شکلههراهبازهمیهکنیم،ه‌همانطورهکههدرهPage Setupهکادرهمحاورهها‌یهFormat → Pageازهمنو‌یه-2

: نمایش اسلید را در حالت نرمال6.3شکل 
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هنشانهدادههایم.6.5شکلههاندازههدلخواههراهانتخابهمیهکنیم،ه‌همانطورهکههدرهFormatازهمنو‌یهکشوییه-3

Page Setup: کادر محاوره ای 6.4شکل 
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سربرگ و پابرگ- 6.2 
شماره گذار‌ی اسلید- 6.2.1 

برا‌یهراهشمارههگذار‌یهاسلید‌هاهمراحلهزیرهراهانجامهمیهد‌هیم:
هراهبازهمیهکنیم.Header and Footerهرفتههوهکادرهمحاورهها‌یهInsert>Page numberبههمسیره.1
هنشانهدادههایم.6.6شکلههراهانتخابهمیهکنیم،ه‌همانطورهکههدرهSlide number،هگزینهه‌یهSlidesدرهسربرگ.2

Format: منوی کشویی 6.5شکل 
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هاولینهاسلیدهشمارههگذار‌یهنخوا‌هدهشد.Do not show on the first slideدرهصورتهانتخابهگزینهه.3

: کادر محاوره ای برای درج شماره صفحه6.6شکل 



109جزوهه‌یهآ‌موزشیه‌مهارتهکارهباهنرمهافزارهارائهه‌مطلب

درج شماره ‌ی کل اسلیدها - 6.2.2 

هفیلدهشمارههگذار‌یهخودکارهکلهاسلید‌هاهراInsert → Fields → Page Countبرا‌یهدرجهشمارههکلهاسلید‌هاهازهمسیره
انتخابهمیهکنیم.

: شماره گذاری خودکار کل اسلیدها6.7شکل 
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ویرایش سر صفحه و پاصفحه - 6.2.3 
برا‌یهویرایشهوهدرجهسرصفحههوهپاصفحههمراحلهزیرهراهانجامهمیهد‌هیم:

هراهبازهمیهکنیم.Header and Footerهرفتههوهکادرهمحاورهها‌یهInsert>Header and Footerبههمسیره.1
هراهفعالهمیهکنیم.Footerگزینهه.2
هنشانهدادههایم.6.8شکلههمتنهسرصفحههوهپاصفحههراهدرجهمیهکنیم،ه‌همانطورهکههدرهFooter textدرهکادره.3
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یادداشت گذار‌ی- 6.3 
یادداشته‌هاهیکهراههمناسبهراهبرا‌یهایجادهیادآور‌یهیاهاضافههکردنهاطلاعاتهاضههافیهبههههاسههلید‌هاهدرهیههکهارائههه،هفرا‌هههم
میهکنند.هیادداشتههههه‌هاهدرهطولهیکهارائههنمایشهدادههنمیهشوند.هبهه‌هرحالهزمانهاستفادههازهنمایشهدوگانههیادداشههته‌هاهبههرهرو‌ی

Header and Footer: کادر محاوره ای 6.8شکل 
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صفحههنمایشهبههاعنوانهیکهنشانهه‌یهارائههنمایشهدادههمیهشود.ه‌همچنینهشماهمیهتوانیدهازهیادداشته‌هاهپرینتهبگیریدهوهازهآنه‌ههها
بههاعنوانهجزوهههاستفادههکنید.

اضافه کردن یادداشت به اسلیدها برا‌ی کمک به ارائه دهنده - 6.3.1 
برا‌یهدرجهیادداشتهبرا‌یه‌هرهاسلیدهمراحلهزیرهراهانجامهمیهد‌هیم:

اسلید‌یهراهکههمیهخوا‌هیدهیادداشتیهبههآنهاضافههنماییدهانتخابهمیهکنیم..1
یرهNotesبرهرو‌یهسربرگه.2 ههمس لیهب و‌یهاص وارهمن اهازهن Viewهکههدرهبال‌یهفضا‌یهکار‌یهاقرارهدارد،هکلیکهکنیدهی  >

Notes PageهبرویدهتاهنمایشهNotes.هبازهشود
برا‌یهاضافههکردن،هتایپهوهیاهچسباندنه(الصااق)همتنهیاهاشیاءهگرافیکیهموردهنیاز،هدرهجعبههمتنهنشانهدادههشدههکلیک.3

میهکنیم.
هنشانهدادههایم.6.9شکلههبرهمیهگردیم،ه‌همانطورهکههدرهNormalزمانیهکههواردهکردنهیادداشتهتمامهشد،هبههنمایشه.4
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چاپ- 6.4 
دگانههدرImpressنرمهافزاره لید‌ها‌یهچن الهاس هگزینهه‌ها‌یهزیاد‌یهراهبرا‌یهچاپهگرفتنهیکهارائههفرا‌همهمیهکند.هبرا‌یهمث

یکهصفحه،هاسلیدهمنحصرهبههفردهدره‌هرهصفحه،هاسلید‌هاهباهیادداشته‌هاهبههاعنوانهیکهطرحهکلی،هباهتاریخهوهزمان،هباهنامهصفحههو
<Fileغیره،هزمانیهکههویرایشهوهایجادهاسلید‌هاهتمامهشدهوهماهخواستیمهکههازهاسلید‌هاهچاپهبگیریمهبههههمسههیره  Printههو هرفت

اپهراGeneralهراهبازهمیهکنیم.هازهاینهکادرهمحاورهها‌یهوهسربرگهPrintکادرهمحاورهها‌یه هگزینهه‌ها‌یهموجودهبرا‌یهپیشهنمایشهچ
هنشانهدادههایم.6.10شکلهانتخابهمیهکنیم،ه‌همانطورهکههدره

Notes: نمایش 6.9شکل 
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تنظیمات چاپ- 6.4.1 
رTools>Option،هکههازهمسیرهOptionsبرا‌یهتغییرهتنظیماتهچاپهدرهیکهارائه،هدرهکادرهمحاورهها‌یه ود،هب ا‌هرهمیهش هظ

هکلیکهمیهکنیم.LibreOffice Impress > Printرو‌یه
بخش چاپ
Page name.ه(نامهصفحه):همشخصهمیهکندهکههنامهصفحههچاپهشود

Date.ه(تاریخ):همشخصهمیهکندهکههتاریخهفعلیهچاپهشود
Time.ه(زمان):همشخصهمیهکندهکههزمانهفعلیهچاپهشود

Print: کادر محاوره ای 6.10شکل 
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Hidden pages.ه(صفحاتهمخفی)ه–همشخصهمیهکندهکههصفحاتیهکههدرهحالهحاضرهمخفیه‌هستندهچاپهشود
بخش تنظیمات صفحه

Default.ه(پیشهفرض)ه–همشخصهمیهکندهکههویژگیه‌ها‌یهصفحاتهمقیاسهچاپهشود
Fit to pageه(مناسبهبرا‌یهصفحه)ه–همقیاسهاشیاءههفراترهازهاندازهه‌یهحاشیهه‌یهچاپگرهفعلیهراهبههگونهها‌یهتنظیمهمیهکندهکه

آنه‌هاهبرا‌یهچاپهبرهرو‌یهکاغذهمناسبهباشند.
Tile pagesه(صفحاتهکوچک):هاگرهصفحاتهیاهاسلیده‌هاهکوچکترهازهبرگههباشند،هچندینهصفحههیاهاسلیدهدرهیکهصفحههاز

برگههچاپهخوا‌هندهشد.
Brochureه(بروشور):هبرا‌یهچاپهسندهدرهفرمتهبروشور،هاینهگزینههراهانتخابهمیهکنیم.هماهمیهتوانیمهدرهموردهچاپهجلوهیا

پشتهوهیاه‌هرهدوهطرفهبروشورهتصمیمهبگیریم.
Front.ه(جلو):هبرا‌یهچاپهجلو‌یهیکهبروشورهاینهگزینههراهانتخابهمیهکنیم
Back.ه(اعقب):هبرا‌یهچاپهپشتهیکهبروشورهاینهگزینههراهانتخابهمیهکنیم

Paper tray from printer settingsبه راه کاغذهچاپگره تغذیهه تنظیمهسینیه اجازهه تنظیماتهچاپگر):ه ازه ه(سینیهصفحهه
کاربرهمیهد‌هد.

بخش کیفیت
Default.ه(پیشهفرض):همشخصهمیهکنیمهرنگه‌ها‌یهاصلیهچاپهشوند

Grayscale.ه(خاکستر‌ی):همشخصهمیهکنیمهرنگه‌هاهخاکستر‌یهچاپهشوند
Black & whiteشکلهه(سیاههوهسفید):همشخصهمیهکنیمهرنگه‌هاهراهبههصورتهسیاههوهسفیدهچاپهشوند،ه‌همانطورهکههدره

هنشانهدادههایم.6.11
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چاپ کردن اسلیدها در فرمت ها‌ی خروجی مختلف- 6.4.2 
)هاقرارهداردهکلیکهمیهکنیمهیاهدرهنههوارهمنههو‌یهاصههلیهبهههWorkspaceهکههدرهبال‌یهفضا‌یهکار‌یه(Notesبرهرو‌یهسربرگه
View > Notes Pageهمیهرویمهتاهنما‌یهNotes:هبازهشود،هسپسهمراحلهزیرهراهانجامهمیهد‌هیم

هبازهشود.PDFهمیهرویمهتاهکادرهمحاورهها‌یهFile > Export as PDFدرهنوارهمنو‌یهاصلیهبهه
هکلیکهمیهکنیم.Generalبرهرو‌یهسربرگه
هراهانتخابهمیهکنیم.Export notes pages،هگزینهه‌یهGeneralدرهبخشه

ههدرOkتغییراتهدلخواههدیگرهراهنیزهدرهاینهصفحههتنظیمهوهبرهرو‌یه انطورهک هکلیکهمیهکنیمهتاهاینهکادرهبستههشود،ه‌هم
هنشانهدادههایم.6.12شکله

Print برای تنظیم Options: کادر محاوره ای 6.11شکل 
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درهکادرهمحاورهها‌یهبعد‌یهیکهنامهفایلهوهمسیر‌یهکههمیهخوا‌هیدهفایلهراهدرهآنهذخیرههشودهراهواردهمیهکنیم.
هبستههشود.Exportهکلیکهمیهکنیمهتاهفایلهذخیرههوهکادرهمحاورهها‌یهExportبرهرو‌یه

نمایش اسلیدها - 6.5 
شروع نمایش اسلیدها از اسلید مورد نظر- 6.5.1 

برا‌یهشروعهنمایشهاسلید‌هاهازهاولینهاسلیدهمیهتوانیمهازهروشه‌ها‌یهزیرهاستفادههکنیم:•
هنشانهدادههایم.6.13شکلههازهصفحههکلیدهراهفشارهمیهد‌هیم،ه‌همانطورهکههدرهF5دکمهه‌ی.1

PDF: کادر محاوره ای 6.12شکل 
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هدرهنوارهابزارهکلیکهمیهکنیم.Start from first slideبرهرو‌یهایکونه.2
همیهرویم.Slideshow>Start from first slideبههمسیره.3

برا‌یهشروعهنمایشهاسلید‌هاهازهیکهاسلیدهدلخواههمیهتوانیمهازهروشه‌ها‌یهزیرهاستفادههکنیم:•
هازهصفحههکلیدهراهفشارهمیهد‌هیم.Shift+F5دکمهه‌ی.1
همیهرویم.Slideshow>Start from current slideبههمسیره.2

استفاده از ابزار هدایت و ناوبر‌ی رو‌ی صحنه- 6.5.2 
ادرNavigatorابزاره‌هدایتهوهناوبر‌یهکهه‌همانه داگانههدرهک هاستهابزار‌یهاستهکههباهآنهمیهتوانهاسلید‌هاهراهبههصورتهج

هدید.هبرا‌یهدستیابیهبههاینهابزارهازهروشه‌ها‌یهزیرهاستفادههمیهکنیم:Navigatorمحاورهها‌یه
هنشانهدادههایم.6.14شکلههمیهرویم،ه‌همانطورهکههدرهView>Navigatorبههمسیره.1

: نمایش اسلیدها6.13شکل 
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هاستفادههمیهکنیم.Ctrl+Shift+F5ازهکلید‌ها‌یهمیانبره.2

مخفی کردن اسلیدها - 6.5.3 
ممکنهاستهنخوا‌هیمهکههتمامیهاسلید‌هاهبههطورهمنظمهدرهنمایشهاسلید‌هاهنشانهدادههشوند،هیعنههیهبرخههیهازهاسههلیده‌ها
للهممکنهاستهماهبعضیهاسلیده‌هاهراهداشتههباشیمهکههشههاملهاطلاعههاتی حذف،هیاهدرهیکهنمایشهسفارشیهنمایشهدادههنشود.همث

برا‌یهخودمانهاستهنههبرا‌یهمخاطبان.ه
برا‌یهمخفیهکردنهیکهاسلیدهبههروشهزیرهاعملهمیهکنیم:

،هاسلید‌هاییهکههمیهخوا‌هیمهمخفیهشوندهراهانتخابهمیهکنیم.Slide SorterهیاهدرهنمایشهSlides paneدرهاقسمته.1
هراهکلیکهمیهکنیم،ه‌همانطورHide SlideهیاهراستهکلیکهکردههوSlide ViewهدرهنوارابزارهHide Slideبرهرو‌یهآیکونه.2

هنشانهدادههایم.6.15شکلهکههدره

Navigator: کادر محاوره ای 6.14شکل 
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هنشانهدادههایم.6.16شکلهاکنونهاسلید‌یهکهه‌هاشورهخوردههاند،همخفیهشدههاند،ه‌همانطورهکههدره

برا‌یهنمایشهیکهاسلیدهمخفیهآنه‌هاهراهانتخابهوهیکیهازهروشه‌ها‌یهزیرهراهانجامهمیهد‌هیم:
هکلیکهمیهکنیم.Slide ViewهدرهنوارابزارهShow Slideبرهرو‌یهآیکونه•
هراهکلیکهمیهکنیم.Show Slideراستهکلیکهکردههوه•
هنشانهدادههایم.6.17شکلههمیهرویم،ه‌همانطورهکههدرهSlide Show>Show Slideدرهنوارهمنو‌یهاصلیهبهه•

: اسلیدهای مخفی شده6.16شکل 

Slide View در نوارابزار Hide Slide: آیکون 6.15شکل 
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Slide View در نوارابزار Show Slide: آیکون 6.17شکل 
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منابع مهارت کار با نرم افزار ارائه ‌ی مطالب-  7 
1. www.libreoffice.org
2. www.impress.com
3. www.gofree.com/Tutorials/LibreOfficeImpress1.php
4. www.tutorialsforopenoffice.org/category_index/presentation.html
5. www.lpgallery.mb.ca/index.html
6. www.slideshare.net/ahsanbham/open-office-impress-tutorial
7. www.itdesk.info/en/module-6-presentation/
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